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รายละเอียดรายวิชา 

การผลิตสื่อสิ่งพิมพ์ รหัสวิชา  (20901 - 9207) 

จ านวน  3  หน่วยกิต  6 ชั่วโมง/สัปดาห์ เวลาเรียนจ านวน  72 ชั่วโมง/ภาคเรียน 

หลักสูตรประกาศนียบัตรวิชาชีพ  สาขาวิชาเทคโนโลยีสารสนเทศ 

 
 
 
 
 

1. รู้จักประเภทของสื่อสิ่งพิมพ์ 
2. เข้าใจกระบวนการผลิตสื่อสิ่งพิมพ์ 
3. สามารถออกแบบและจัดหน้าสื่อสิ่งพิมพ์ 
4. สามารถใช้โปรแกรมสําเร็จรูปเพื่อผลิตสื่อสิ่งพิมพ์ 
5. มีกิจนิสัยและส่งเสริมคุณธรรม จริยธรรม ค่านิยมท่ีดีในการใช้คอมพิวเตอร์ 

 
 
 

1. แสดงความรู้และหลักการเกี่ยวกับการผลิตสื่อสิ่งพิมพ์ 
2. ปฏิบัติการผลิตสื่อสิ่งพิมพ์ด้วยโปรแกรมสําเร็จรูป 

 
 
 
 
 

ศึกษาและปฏิบัติเกี่ยวกับความหมายและประเภทของสื่อสิ่งพิมพ์ บทบาทของสื่อสิ่งพิมพ์ กระบวนการ 
ผลิตสื่อสิ่งพิมพ์แบบ Desktop Publishing การจัดรูปแบบ การเลือกใช้ตัวอักษรการเลือกสี ประเภทของภาพ
และการเลือกภาพประกอบสิ่งพิมพ์การผลิตและจัดหน้าสิ่งพิมพ์ด้วยโปรแกรมสําเร็จรูป 

จุดประสงค์รายวิชา 

สมรรถนะรายวิชา 

ค าอธิบายรายวิชา 
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แผนจัดการเรียนรู้แบบบูรณาการ 
ช่ือรายวชิา  การผลติส่ือส่ิงพมิพ์ รหัสวชิา 2204-2104 

หมวดวชิาชีพ  วชิาชีพสาขางาน  ประกาศนียบัตรวชิาชีพ (ปวช.) 
          จ านวน   2  หน่วยกติ จ านวนช่ัวโมงรวม  72 ช่ัวโมง 

--------------------------------------------------------------------------------------------------------------------- 
จุดประสงค์รายวชิาเพ่ือให้ 

1. มีความรู้ความเขา้ใจเก่ียวกบัการวเิคราะห์และจ าแนกประเภทของส่ือส่ิงพิมพ ์

2. มีความรู้ความเขา้ใจเก่ียวกบักระบวนการพิมพ ์

3. มีทกัษะในการออกแบบส่ือส่ิงพิมพแ์ละจดัองคป์ระกอบศิลป์ในส่ือส่ิงพิมพ ์

4. ผลิตส่ือส่ิงพิมพด์ว้ยโปรแกรมผลิตส่ือส่ิงพิมพ ์

5. มีคุณธรรม จริยธรรม และค่านิยมท่ีดีในการใชค้อมพิวเตอร์ 

สมรรถนะรายวชิา 

1. แสดงความรู้เก่ียวกบัหลกัการพื้นฐานของส่ือส่ิงพิมพ ์

2. การออกแบบส่ือส่ิงพิมพต์ามการใชง้าน 

3. ผลิตส่ือส่ิงพิมพด์ว้ยโปรแกรมผลิตส่ือส่ิงพิมพ ์

ค าอธิบายรายวชิา 

ศึกษาและปฏิบติัเก่ียวกบัความรู้พื้นฐานของส่ือส่ิงพิมพ ์กระบวนการพิมพ ์การออกแบบส่ือ 

ส่ิงพิมพ ์เทคนิคการใชภ้าพถ่ายในส่ือส่ิงพิมพ ์และการใชโ้ปรแกรมผลิตส่ือส่ิงพิมพ ์
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ตารางวเิคราะห์ค าอธิบายรายวชิา 

ช่ือวชิา  การผลติส่ือส่ิงพมิพ์    รหัสวชิา 2204-2104     จ านวน    3  หน่วยกติ 
ระยะเวลาเรียน  18  สัปดาห์   จ านวน   4  ช่ัวโมง / สัปดาห์   รวมจ านวน   72  ช่ัวโมง 

 

ล าดับ
ที่ 

ช่ือหน่วยการเรียนรู้ 
พฤติกรรมทีค่าดหวงัต่อการเรียนการสอน 1 คร้ัง 

ความรู้ ทกัษะ จิตพสัิย รวม(ชม.) 
1. ความรู้พื้นฐานเก่ียวกบัส่ือส่ิงพิมพ ์ 4 1 1 4 
2 หลกัการออกแบบส่ือส่ิงพิมพ ์ 4 1 1 8 
3 กระบวนการพิมพ ์ 4 1 1 4 
4 รู้จกักบัโปรแกรม Indesign CS6 1 4 1 4 
5 การจดัการไฟลง์านและเคร่ืองมือพื้นฐาน 1 4 1 4 
6 การท างานกบัขอ้ความ 1 4 1 8 
7 การปรับแต่งและจดัวางขอ้ความ 1 4 1 8 
8 การวาดวตัถุประกอบ 1 4 1 8 
9 การใชง้านวตัถุ 1 4 1 8 

10 ความรู้เร่ืองสีและการใชง้านสี 1 4 1  8 
11 เทคนิคการปรับแต่งภาพ 1 4 1 8 

   13 การประเมินผลการเรียน  
รวม 72 
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ตารางวเิคราะห์การประเมินผลตามสภาพจริง 

 

หน่วยที่ จุดประสงค์การเรียนรู้ เคร่ืองมือวดัผล คะแนน หมายเหตุ 

1. ความรู้พื้นฐานเก่ียวกบัส่ือส่ิงพิมพ ์ ขอ้สอบอตันยั 2 จุดประสงคก์ารเรียนรู้ท่ี

ไม่ผา่นครูผูส้อน

มอบหมายงานเพิ่มเติมเพื่อ

เป็นการพฒันาความรู้และ

ทบทวนบทเรียนของ

ผูเ้รียน หากพบวา่ยงัไม่

ผา่นจุดประสงคก์ารเรียนรู้

อีก จดัสอนซ่อมเสริมให้ 

2. หลกัการออกแบบส่ือส่ิงพิมพ ์ ขอ้สอบอตันยั 2 

3. กระบวนการพิมพ ์ ขอ้สอบอตันยั 2 

4. รู้จกักบัโปรแกรม Indesign CS6 แบบประเมิน 2 

5. การจดัการไฟลง์านและเคร่ืองมือพื้นฐาน แบบประเมิน 2 

6. การท างานกบัขอ้ความ แบบประเมิน 2 

7. การปรับแต่งและจดัวางขอ้ความ แบบประเมิน 2 

8. การวาดวตัถุประกอบ แบบประเมิน 2 

9. การใชง้านวตัถุ แบบประเมิน 2 

10. ความรู้เร่ืองสีและการใชง้านสี แบบประเมิน 2 

11. เทคนิคการปรับแต่งภาพ แบบประเมิน 2 
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แผนจัดการเรียนรู้ 
 

สัปดาห์
ที่ 

หน่วยการเรียนรู้/เน้ือหา กจิกรรม 

1 บทท่ี 1 ความรู้พื้นฐานเก่ียวกบัส่ือส่ิงพิมพ ์
1. ประวติัการพิมพท์ั้งในและต่างประเทศ 
2.กระบวนการพิมพแ์บบดั้งเดิมและการพิมพร่์วม
สมยั 
3. ประเภทของส่ือส่ิงพิมพ ์ 
4. องคป์ระกอบของส่ือส่ิงพิมพ ์
5. หนา้ท่ีของส่ือส่ิงพิมพ ์ 
6. บทบาทของส่ือส่ิงพิมพ ์

ใหน้กัศึกษาคน้ควา้หน่วยการเรียน 
บรรยาย  
อธิบาย ยกตวัอยา่ง  
แสดงวธีิการปฏิบติัในแต่ ละหวัขอ้
การเรียนและใหน้กัศึกษาปฏิบติัไป
พร้อมกนั 
สรุปบทเรียน 
แบบฝึกหดั / ทดสอบ 

2-3 บทท่ี 2 หลกัการออกแบบส่ือส่ิงพิมพ ์
1. องคป์ระกอบการออกแบบ 
2. หลกัการออกแบบ 
3. การออกแบบหนงัสือพิมพ ์
4. ตน้ฉบบังานพิมพ ์
5. เทคโนโลยเีตรียมตน้ฉบบังานพิมพ ์

 

ใหน้กัศึกษาคน้ควา้หน่วยการเรียน 
บรรยาย  
อธิบาย ยกตวัอยา่ง  
แสดงวธีิการปฏิบติัในแต่ ละหวัขอ้
การเรียนและใหน้กัศึกษาปฏิบติัไป
พร้อมกนั 
สรุปบทเรียน 
แบบฝึกหดั / ทดสอบ 

4 บทท่ี 3 กระบวนการพิมพ ์
1. การเตรียมตน้ฉบบัก่อนการพิมพ ์
2. ตวัพิมพ ์
3. พื้นฐานทางสี 
4. การแยกสี 
5. ระบบการพิมพ ์
6. หมึกพิมพ ์
7. กระดาษ 
8. การท าใหแ้ลว้เสร็จ 

ใหน้กัศึกษาคน้ควา้หน่วยการเรียน 
บรรยาย  
อธิบาย ยกตวัอยา่ง  
แสดงวธีิการปฏิบติัในแต่ ละหวัขอ้
การเรียนและใหน้กัศึกษาปฏิบติัไป
พร้อมกนั 
สรุปบทเรียน 
แบบฝึกหดั / ทดสอบ 
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สัปดาห์

ที่ 
หน่วยการเรียนรู้/เน้ือหา กจิกรรม 

5 บทท่ี 4 รู้จกักบัโปรแกรม Indesign CS6 
1. รู้และเขา้ใจในโปรแกรม Adobe InDesign 
2. อธิบายการเขา้สู่โปรแกรม Adobe InDesign ได ้
3. อธิบายเก่ียวกบัแถบค าสั่งของโปรแกรม Adobe 

InDesign ได ้
4. อธิบายเก่ียวกบักล่องเคร่ืองมือของโปรแกรม 

Adobe InDesign ได ้
5. อธิบายเก่ียวกบัคอนโทรลพาเนลของโปรแกรม 

Adobe InDesign ได ้
6. อธิบายเก่ียวกบัพาเนลควบคุมการท างานได ้
7. สามารถจดัการกบัหนา้ต่างการท างานได ้
8. สามารถก าหนดคียล์ดัได ้
9. อธิบายเก่ียวกบัโปรแกรมช่วยจดัการขอ้ความ

ภาษาไทยได ้

- ให้นกัศึกษาคน้ควา้ประจ าหน่วย
การเรียน 

- แบ่งกลุ่มใหไ้ปศึกษา 
- บรรยาย 
- แสดงวธีิท าและยกตวัอยา่ง 
- ใหน้กัศึกษาแสดงวธีิท า 
- สรุปบทเรียน 
- แบบฝึกหดั/ทดสอบ 

6 บทท่ี 5 การจดัการไฟลง์านและเคร่ืองมือพื้นฐาน 
1. รู้และเขา้ใจในโปรแกรม Adobe InDesign 
2. อธิบายการเขา้สู่โปรแกรม Adobe InDesign ได ้
3. อธิบายเก่ียวกบัแถบค าสั่งของโปรแกรม Adobe 

InDesign ได ้
4. อธิบายเก่ียวกบักล่องเคร่ืองมือของโปรแกรม 

Adobe InDesign ได ้
5. อธิบายเก่ียวกบัคอนโทรลพาเนลของโปรแกรม 

Adobe InDesign ได ้
6. อธิบายเก่ียวกบัพาเนลควบคุมการท างานได ้
7. สามารถจดัการกบัหนา้ต่างการท างานได ้
8. สามารถก าหนดคียล์ดัได ้
9. อธิบายเก่ียวกบัโปรแกรมช่วยจดัการขอ้ความ 

- ให้นกัศึกษาคน้ควา้ประจ าหน่วย
การเรียน 

- แบ่งกลุ่มใหไ้ปศึกษา 
- บรรยาย 
- แสดงวธีิท าและยกตวัอยา่ง 
- ใหน้กัศึกษาแสดงวธีิท า 
- สรุปบทเรียน 
- แบบฝึกหดั/ทดสอบ 
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สัปดาห์

ที่ 
หน่วยการเรียนรู้/เน้ือหา กจิกรรม 

7-8 บทท่ี 6  การท างานกบัขอ้ความ 
1. อธิบายการสร้างขอ้ความประเภทต่างๆ ได ้
2. บอกเก่ียวกบัการปรับแต่งขอ้ความแบบ Type on 
Path ได ้
3. รู้จกัเก่ียวกบัขอ้ความใน Adobe InDesign 
4. สามารถคดัลอกขอ้ความจากไฟลโ์ปรแกรมอ่ืนๆ 
มาใชง้านได ้
5. อธิบายการไหลของขอ้ความได ้
6. อธิบายเก่ียวกบัการใชค้อลมัน์ได ้
7. สามารถตดัและรวมขอ้ความได ้
8. สามารถแกไ้ขขอ้ความในพื้นท่ี Story Editor ได ้

- ให้นกัศึกษาคน้ควา้ประจ าหน่วย
การเรียน 

- แบ่งกลุ่มใหไ้ปศึกษา 
- บรรยาย 
- แสดงวธีิท าและยกตวัอยา่ง 
- ใหน้กัศึกษาแสดงวธีิท า  
- สรุปบทเรียน 
- แบบฝึกหดั/ทดสอบ 

9-10 บทท่ี 7 การปรับแต่งและจดัวางขอ้ความ 
1. สามารถปรับแต่งอกัษรจากพาเนล Charactor ได ้
2. อธิบายการปรับแต่งอกัษรจาก Control Panel ได ้
3. บอกวธีิการจดัเรียงขอ้ความได ้
4. อธิบายการข้ึนตน้ยอ่หนา้ดว้ตวัอกัษรขนาดใหญ่ได ้
5. รู้จกัเก่ียวกบัสไตลข์อ้ความ 
6. สามารถการเปล่ียนสีขอ้ความได ้
7. อธิบายการนบัค าในขอ้ความได ้

- ให้นัก ศึกษาค้น คว้าป ระจ า
หน่วยการเรียน 

- บรรยาย 
- แสดงวธีิท าและยกตวัอยา่ง 
- ใหน้กัศึกษาแสดงวธีิท า 
- สรุปบทเรียน 
- แบบฝึกหดั/ทดสอบ 
- สรุปบทเรียน 
- แบบฝักหดั / ทดสอบ 

11-12 บทท่ี 8 การวาดวตัถุประกอบ 
1. รู้จกัเก่ียวกบัเส้นพาธ 
2. สามารถการวาดเส้นตรงได ้
3. สามารถวาดรูปทรงแบบตายตวัได ้
4. สามารถวาดรูปทรงอยา่งอิสระได ้

  

- ให้นัก ศึกษาค้น คว้าป ระจ า
หน่วยการเรียน 

- บรรยาย 
- แสดงวธีิท าและยกตวัอยา่ง 
- ใหน้กัศึกษาแสดงวธีิท า 
- สรุปบทเรียน 
- แบบฝึกหดั/ทดสอบ 
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สัปดาห์

ที่ 
หน่วยการเรียนรู้/เน้ือหา กจิกรรม 

13-14 บทท่ี 9 การใชง้านวตัถุ 
1. อธิบายการเลือกและเคล่ือนยา้ยวตัถุได ้
2. สามารถปรับขนาดวตัถุได ้
3. สามรถคดัลอก และวางวตัถุโดยใช ้Paste  
      in Place ได ้
4. บอกวธีิการหมุนวตัถุโดยใช ้Rotating Tool ได ้
5. สามารถบิด และการพลิกกลบัดา้นวตัถุได ้
6. อธิบายการล็อควตัถุได ้
7. อธิบายการคร็อปรูปภาพได ้
8. สามารถลบวตัถุได ้
9. อธิบายการมาสกว์ตัถุได ้
10. อธิบายการรวมกลุ่ม และจดัล าดบัการซอ้นวตัถุได ้
11.สามารถจดัเรียงวตัถุได ้
 

- ให้นัก ศึกษาค้น คว้าป ระจ า
หน่วยการเรียน 

- บรรยาย 
- แสดงวธีิท าและยกตวัอยา่ง 
- ใหน้กัศึกษาแสดงวธีิท า 
- สรุปบทเรียน 
- แบบฝึกหดั/ทดสอบ 
- สรุปบทเรียน 
- แบบฝักหดั / ทดสอบ 

15-16 บทท่ี 10 ความรู้เร่ืองสีและการใชง้านสี 
1. รู้จกัโมเดลการมองเห็นสีทัว่ไป 
2. บอกโหมดสีท่ีใชง้านโปรแกรม InDesign ได ้
3. อธิบายการใส่สีใหว้ตัถุได ้
4. อธิบายการเลือกสีจาก Color Picker, พาเนล Color 

และพาเนล Swatches ได ้
5. สามารถท าการระบายสีดว้ยเคร่ืองมือ Eyedropper 

Tool ได ้
6. สามารถการระบายสีแบบไล่โทนได ้

  
 
 
 

- ให้นัก ศึกษาค้น คว้าป ระจ า
หน่วยการเรียน 

- บรรยาย 
- แสดงวธีิท าและยกตวัอยา่ง 
- ใหน้กัศึกษาแสดงวธีิท า 
- สรุปบทเรียน 
- แบบฝึกหดั/ทดสอบ 
- สรุปบทเรียน 
- แบบฝักหดั / ทดสอบ 
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สัปดาห์

ที่ 
หน่วยการเรียนรู้/เน้ือหา กจิกรรม 

17-18 บทท่ี 11 เทคนิคการปรับแต่งภาพ 
1. รู้และเขา้ใจในการตั้งค่าการแสดงผล 
2. อธิบายการปรับแต่งภาพได ้
3. สามารถจดัวางขอ้ความลอ้มรอบรูปภาพได ้
4. อธิบายการใชง้านเฟรมกบัภาพได ้
5. สามารถใส่ภาพรวมกบัขอ้ความได ้

  

- ให้นัก ศึกษาค้น คว้าป ระจ า
หน่วยการเรียน 

- บรรยาย 
- แสดงวธีิท าและยกตวัอยา่ง 
- ใหน้กัศึกษาแสดงวธีิท า 
- สรุปบทเรียน 
- แบบฝึกหดั/ทดสอบ 
- สรุปบทเรียน 
- แบบฝักหดั / ทดสอบ 

    ประเมินผลผูเ้รียน  
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แผนจัดการเรียนรู้   หน่วยที ่1 

รายวชิา    การผลิตส่ือส่ิงพิมพ ์ สอนคร้ังที ่1 

ช่ือเร่ือง   ความรู้พื้นฐานเก่ียวกบัส่ือส่ิงพิมพ ์ จ านวน  4 ช่ัวโมง 

 
1. สาระส าคัญ 

ส่ือส่ิงพิมพ ์เป็นส่วนหน่ึงของส่ือสารมวลชน จ าแนกได ้2 ประเภทไดแ้ก่ ส่ือส่ิงพิมพท่ี์ก าหนดระยะ 

เวลาการเผยแพร่ และไม่ก าหนดระยะเวลาการเผยแพร่ ส่ือส่ิงพิมพมี์องคป์ระกอบส าคญั ไดแ้ก่ เน้ือหา  ภาพ และ

การออกแบบหนา้ท่ีส่ือส่ิงพิมพ ์ไดแ้ก่ ใหข้อ้มูลข่าวสาร (to inform) ใหค้วามรู้ความเขา้ใจ (to educate) ใหค้วาม

คิดเห็น (to give an opinion) ใหค้วามบนัเทิง (to entertain) และใหก้ารโฆษณา (to advertise) ในประเด็นบทบาท

ของส่ือส่ิงพิมพ ์ไดแ้ก่ สถาบนัการศึกษา (Educational institute) ตลาดเสรีแห่งความคิด (Freedom of Opinion 

market place) ผูเ้ฝ้ายามข่าวสาร (Gatekeeper) และองคก์รควบคุมบรรทดัฐานสังคม (Society Norm Inspector) 

2 . จุดประสงค์การเรียนรู้ 

1. มีความรู้ความเขา้ใจและบอกล าดบัประวติัการพิมพท์ั้งในและต่างประเทศได ้
2 . มีความรู้ความเขา้ใจและบอกความแตกต่างระหวา่งกระบวนการพิมพแ์บบดั้งเดิม และการพิมพร่์วม
สมยัได ้
3. มีความรู้ความเขา้ใจและจ าแนกประเภทส่ือส่ิงพิมพไ์ด ้
4. มีความรู้ความเขา้ใจและบอกองคป์ระกอบของส่ือส่ิงพิมพไ์ด ้   
5. มีความรู้ความเขา้ใจและบอกหนา้ท่ีของส่ือส่ิงพิมพไ์ด ้ 
6.   มีความรู้ความเขา้ใจและอธิบายบทบาทของส่ือส่ิงพิมพไ์ด ้

3. สาระการเรียนรู้ 

1. ประวติัการพิมพท์ั้งในและต่างประเทศ 
2. กระบวนการพิมพแ์บบดั้งเดิมและการพิมพร่์วมสมยั 
3. ประเภทของส่ือส่ิงพิมพ ์ 
4. องคป์ระกอบของส่ือส่ิงพิมพ ์
5. หนา้ท่ีของส่ือส่ิงพิมพ ์ 
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6. บทบาทของส่ือส่ิงพิมพ ์
4. การวดัประเมินผล 

ทกัษะพิสัย มีกระบวนการวางแผน และปฏิบติัไดต้รงตามเป้าหมายท่ีก าหนด 
พุทธิพิสัย มีความจ า ความเขา้ใจ และการน าไปประยกุตใ์หเ้กิดประโยชน์ต่อการเรียน หรือการใช้

ชีวติประจ าวนั 
 จิตพิสัย ปฏิบติัไดต้ามศกัยภาพท่ีมีอยู ่ตรงต่อเวลา และสนใจในการสืบคน้หาความรู้ ทุกช่วง

โอกาสเพื่อพฒันาตนเอง 
5. กจิกรรมการเรียนการสอน 

 กจิกรรมครู 

ข้ันน าเข้าสู่บทเรียน (สัปดาห์ละ 30 นาท)ี 
1.  ใหค้วามร่วมมือกบัครูในการตรวจสอบ 
2. คน้ควา้เร่ือง ส่ือส่ิงพิมพ ์
3. ร่วมสนทนาและแสดงความคิดเห็น 
4. ท าแบบทดสอบก่อนเรียน 
ขั้นด าเนินการสอน (สัปดาห์ละ 180 นาท)ี 
1. ฟัง ท าความเขา้ใจและซกัถาม 
2. แบ่งกลุ่ม 
3. ฟัง ท าความเขา้ใจและปฎิบติัตาม 
4. ผูเ้รียนซกัถามขอ้สงสัยและจดบนัทึก 
5.  รับการประเมิน 
ข้ันสรุป (สัปดาห์ละ 30 นาท)ี 
1. ครูและนกัเรียนร่วมกนัสรุปสาระส าคญั 
2. นกัเรียนสอบถามขอ้สงสัย 
3. ฟังและจดบนัทึก 
4. ท าแบบฝึกหดัทา้ยบท 
5. ท าแบบทดสอบหลงัเรียน 
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กจิกรรมนักเรียน 

ข้ันน าเข้าสู่บทเรียน (สัปดาห์ละ 30 นาท)ี 
1.  ใหค้วามร่วมมือกบัครูในการตรวจสอบ 

2. คน้ควา้เร่ือง การออกแบบส่ือส่ิงพิมพ ์

3. ร่วมสนทนาและแสดงความคิดเห็น 

4.  ท าแบบทดสอบก่อนเรียน 

ขั้นด าเนินการสอน (สัปดาห์ละ 180 นาท)ี 
1. ฟัง ท าความเขา้ใจและซกัถาม 
2. แบ่งกลุ่ม 
3. ฟัง ท าความเขา้ใจและปฎิบติัตาม 
4. ผูเ้รียนซกัถามขอ้สงสัยและจดบนัทึก 
5.  รับการประเมิน 
ข้ันสรุป (สัปดาห์ละ 30 นาท)ี 
1. ครูและนกัเรียนร่วมกนัสรุปสาระส าคญั 

2. นกัเรียนสอบถามขอ้สงสัย 

3. ฟังและจดบนัทึก 

4. ท าแบบฝึกหดัทา้ยบท 

5. ท าแบบทดสอบหลงัเรียน 

6.  กจิกรรมการเรียนรู้ 

 ก่อนเรียน 
 คน้ควา้เก่ียวกบั ส่ือส่ิงพิมพ ์

ขณะเรียน 
1. แบ่งกลุ่มเพื่อศึกษา 
2. จดบนัทึก สาระการเรียนรู้  
3. ท าใบงาน  ตรวจสอบใบงาน แกไ้ขใบงาน 
4. ทบทวนเน้ือหา 
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หลงัเรียน 

1. ร่วมกนัสรุปบทเรียน พร้อมบนัทึกผลการสรุป แลว้ลุกข้ึนน าเสนอกบัครูผูส้อน 
2. ผูเ้รียนและครูผูส้อนร่วมกนัประเมินขอ้สรุปของผูเ้รียนท่ีออกแสดงความคิดเห็นเพื่อใหไ้ดข้อ้สรุปท่ี

ถูกตอ้ง  และครูผูส้อนแสดงความช่ืนชมกบัผูเ้รียนทุกคนท่ีออกแสดงความคิดเห็นและมีส่วนร่วม
ในกิจกรรมท่ีมอบหมาย 

3. ท าแบบฝึกหดัหลงัเรียน 
4. ร่วมกนัเฉลยแบบฝึกหดั 

7. ส่ือการเรียนการสอนประจ าหน่วย 

1. หนงัสือเรียนวิชา การผลิตส่ือส่ิงพิมพ ์
2. ใบความรู้ประจ าหน่วย 
3. ใบงานและแบบฝึกหดั 
4. เคร่ืองไมโครคอมพิวเตอร์ 
5.  แผน่ใสและเคร่ืองฉายภาพขา้มศีรษะ 
6. ซีดีส่ือการสอน 

8. วดัผลประเมินผลประจ าหน่วย 

1. สังเกตผูเ้รียนมีความสนใจ เกิดความเขา้ใจในสาระการเรียนรู้ ตลอดจนแสดงความกระตือรือร้นใน
การแสดงความคิดเห็นและสรุปสาระการเรียนรู้ประจ าหน่วย  

2. ท าใบงานไดอ้ยา่งถูกตอ้ง  ทนัเวลาท่ีก าหนด  ใบงานสะอาดและเป็นระเบียบ 
3. ผูเ้รียนท าแบบฝึกหดัหลงัเรียนไดถู้กตอ้ง  โดยไดค้ะแนน   50%  เป็นอยา่งต ่า 

9. กจิกรรมเสนอแนะประจ าหน่วย 

1. ผูเ้รียนตอ้งใหค้วามสนใจในการศึกษา  เพื่อหาเทคนิค วธีิการ หรือหลกัการง่ายเพื่อใหห้าค าตอบได้
อยา่งถูกตอ้ง และรวดเร็ว โดยการ ตั้งใจฟังหลกัการ เทคนิควิธีการท่ีครูผูส้อนสรุปในขณะท่ีท าการสอน และน า
ขอ้สงสัยซกัถามครูในการเรียนทุกคร้ังท่ีเกิดความสับสน และไม่เขา้ใจ 

2. ผูมี้การทบทวนบทเรียน ตลอดเพื่อเสริมสร้างความเขา้ใจอยา่งแทจ้ริง 
3. ผูเ้รียนหมัน่ท าใบงาน แบบฝึกหดั และแกไ้ขขอ้ท่ีผดิใหถู้กตอ้งเสมอ 
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4. ผูเ้รียนตอ้งสร้างมโนภาพให้เกิดความคิดรวบยอดในสาระการเรียนรู้และเทคนิควิธีการพร้อมกบั
ความจ าเป็นในการน าไปประยุกตใ์ชใ้ห้เกิดข้ึนโดยตนเองให้ไดเ้พื่อเกิดความรู้ความเขา้ใจอยา่งแทจ้ริงไม่ใช่เกิด
จากการท่องจ า 
 
เฉลยแบบฝึกหัดท้ายบทที ่1 

1. จงสรุปประวติัการพิมพท์ั้งในและต่างประเทศ พอเขา้ใจ 
 ในต่างประเทศการพิมพ์ระยะแรก ชาวจีนได้สลักตราประจ าตระกูล หรือสลักช่ือบนงาช้าง หรือกระดูก
สัตว์เพ่ือท าแหวนและตราประทับ ต่อมาใช้กระดาษท าจากเย่ือไม้ และใช้เขม่าไฟเป็นหมึก ขณะท่ีชาวอียิปต์
ใช้ถ่าน ชาวญีปุ่่นใช้แกะตัวพิมพ์ด้วยไม้แล้วทาหมึกพิมพ์บนกระดาษ จนกระท่ังชาวจีนได้ใช้ดินเหนียวป้ัน
เป็นตัวพิมพ์แล้วเผาไฟ ชาวเกาหลีใช้วิธีการหล่อตัวพิมพ์ ส่วนชาวยโุรปเร่ิมเลียนแบบไปพิมพ์เป็นบลอ็กไม้
แล้วระบายสี และเร่ิมมกีารกัดแม่พิมพ์เป็นร่องลึกโดยใช้ทองแดง จนกระท่ังชาวเยอรมนัช่ือ “กูเตนเบริก” 
ได้หล่อตัวพิมพ์โลหะ ซ่ึงเป็นต้นแบบระบบพืน้นูน หรือเลตเตอร์เพรส จากนั้นได้มกีารพัฒนาการพิมพ์พืน้
ราบ หรือการพิมพ์หิน  

ในประเทศไทยเกิดการพิมพ์จากคณะสอนศาสนาน าเข้ามาเพ่ือการพิมพ์ค าสอนทางศาสนา แล้ว
พัฒนาการหล่อตัวพิมพ์ภาษาไทยขึน้ใช้ในการพิมพ์ 

 
2. กระบวนการผลิตส่ือส่ิงพิมพแ์บบดั้งเดิมและร่วมสมยั มีอะไรบา้ง 

 กระบวนการพิมพ์ดั้งเดิม  พิจารณาจากกระบวนการพิมพ์ได้ ได้แก่   

 1. กระบวนการวางแผนและการ  2. การเรียงพมิพ์และภาพ  3. การจัดแบบตัวพมิพ์  4. การเตรียม

อาร์ตเวิร์ค  และ 5.  การเตรียมต้นฉบับภาพ  

 กระบวนการพิมพ์ร่วมสมยั เป็นการประยกุต์ซอฟท์แวร์คอมพิวเตอร์มาใช้ในงานกระบวนการพิมพ์ ได้แก่  

 1. การเตรียมภาพ  2. ซอฟท์แวร์การเตรียมตัวหนังสือ  3. ซอฟท์แวร์การตรวจค าถูกผิด  และ 4. การ

ออกแบบจัดหน้าและประกอบหน้าต้นฉบับ  

3. ส่ือส่ิงพิมพมี์ก่ีประเภท โดยใชเ้กณฑก์ารแผยแพร่เป็นตวับ่งช้ี 
 2 ประเภทได้แก่ ส่ือส่ิงพิมพ์ ท่ีก าหนดระยะเวลาเผยแพร่ (Period) และ ส่ือส่ิงพิมพ์ ท่ีไม่ก าหนดระยะเวลา
เผยแพร่ (Non-period) 
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4. จงสรุปแนวคิดและสาระส าคญัเก่ียวส่ือส่ิงพิมพ ์ท่ีก าหนดระยะเวลาเผยแพร่ ไดแ้ก่ 

• จดหมายข่าว เป็นหน่ึงในองค์ประกอบแบบจ าลองการส่ือสารมวลชน ประเภทส่ิงพิมพ์รายคาบ เป็น
ตัวกลางเพ่ือส่งผ่านเนือ้หาไปสู่เป้าหมาย และยงัเป็นเคร่ืองมือในการบริหารงาน ในองค์กรท้ัง
ภาครัฐ และเอกชน รวมท้ังเป็นเคร่ืองในการประสานสัมพันธ์ในองค์กรและนอกองค์กร   

• หนังสือพิมพ์ เป็นส่ิงพิมพ์ท่ีน าเสนอช้อมลูข่าวสาร ซ่ึงมีท้ังการเน้นเชิงคุณภาพ น าเสนอเนือ้หาและ
ไปทางเร่ืองหนักสมอง นอกจากนีย้งัมกีารเน้นปริมาณยอดผู้อ่าน โดยน าเสนอเนือ้หาเบาสมอง 

• นิตยสาร เป็นส่ิงพิมพ์ท่ีน าเสนอข้อมลู และข่าวสารท่ีเน้นเร่ืองใดเร่ืองหน่ึง อาชีพใดอาชีพหน่ึง  
หรือคนกลุ่มใดกลุ่มหน่ึง 

5. จงสรุปแนวคิดและสาระส าคญัเก่ียวส่ือส่ิงพิมพ ์ท่ีไม่ก าหนดระยะเวลาเผยแพร่ ไดแ้ก่ 

• ใบปลิว  เป็นเอกสารท่ีน าเสนอข้อมลูข่าวสารบนกระดาษใบเดียว 

• แผ่นพับ เป็นเอกสารท่ีน าเสนอข้อมลูข่าวสารบนกระดาษท่ีมกีารพับหรือเยบ็เป็นเล่ม 
• โปสเตอร์ เป็นแผ่นกระดาษใบเดียว ขนาดใหญ่มเีนือ้ความน้อย ผู้อ่านท่ีเดินทางไปมาสามารถอ่าน

ได้สะดวก 
6. จงสรุปองคป์ระกอบส าคญัของส่ือส่ิงพิมพโ์ดยสังเขป 

 องค์ประกอบของส่ือส่ิงพิมพ์ มส่ีวนส าคัญ 2 ประการได้แก่ เนือ้หาและการออกแบบ 

7. จงอธิบายหนา้ท่ีส่ือส่ิงพิมพต่์อไปน้ี พอเขา้ใจ 

• ให้ข้อมลูข่าวสาร (to inform) บอกข่าวสาร เหตุการณ์ท่ีเกิดขึน้ 
• ให้ความคิดความเห็น (to give an opinion) สะท้อนความคิดเห็นของคนในสังคม 
• ให้ความรู้ความเข้าใจ (to educate ให้ความรู้ความเข้าใจกับวฒันธรรม ประเพณี และส่ิงดีงามในสังคม 
• ให้การบันเทิง (to entertain) ให้ส่ิงท่ีเข้ามาผ่อนคลาย เป็นเร่ืองเบาสมอง 
• ให้การโฆษณา (to advertise) เป็นข้อมลูในทางโน้มน้าว ชักชวน จูงใจให้มผีลทางธุรกิจและ

อุตสาหกรรม 

8. จงอธิบายบทบาทส่ือส่ิงพิมพต่์อไปน้ี พอเขา้ใจ 

• สถาบันการศึกษา (Educational institute) เป็นหนังสือ ต าราและเอกสารท่ีให้ข้อมลู และความรู้ 
• ตลาดเสรีแห่งความคิด (Freedom of Opinion market place) เป็นแหล่งฐานการคิด การท า และการ

แก้ไขปัญหาได้ 
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แผนจัดการเรียนรู้   หน่วยที ่2 

รายวชิา    การผลิตส่ือส่ิงพิมพ ์ สอนคร้ังที ่2 

ช่ือเร่ือง   หลกัการออกแบบส่ือส่ิงพิมพ ์ จ านวน  4 ช่ัวโมง 

1. สาระส าคัญ 
บทท่ีผา่นมาเราไดเ้รียนรู้ถึงประเภท และองคป์ระกอบของงานส่ือส่ิงพิมพก์นัไปแลว้ ส าหรับเน้ือในบทน้ีเราจะ

มาเรียนรู้ถึงหลกัการออกแบบส่ือส่ิงพิมพ ์เพื่อใหง้านส่ิงพิมพข์องเราดูน่าสนใจ 

2 . จุดประสงค์การเรียนรู้ 

1. เพื่อใหผู้เ้รียนสามารถอธิบายองคป์ระกอบการออกแบบได ้

2. เพื่อใหผู้เ้รียนสามารถบอกหลกัการออกแบบได ้   

3. เพื่อใหผู้เ้รียนสามารถบอกองคป์ระกอบตน้ฉบบังานพิมพไ์ด ้

4. เพื่อใหผู้เ้รียนสามารถระบุเทคโนโลยเีตรียมตน้ฉบบังานพิมพไ์ด ้

5. เพื่อใหผู้เ้รียนสามารถอธิบายการออกแบบหนงัสือพิมพไ์ด ้

3. สาระการเรียนรู้ 

1. องคป์ระกอบการออกแบบ 

2. หลกัการออกแบบ 

3. การออกแบบหนงัสือพิมพ ์

4. ตน้ฉบบังานพิมพ ์

5. เทคโนโลยเีตรียมตน้ฉบบังานพิมพ ์

4. การวดัประเมินผล 

ทกัษะพิสัย  มีกระบวนการวางแผน และปฏิบติัไดต้รงตามเป้าหมายท่ีก าหนด 

พุทธิพิสัย มีความจ า ความเขา้ใจ และการน าไปประยกุตใ์ห้เกิดประโยชน์ต่อการเรียน 

หรือการใชชี้วติประจ าวนั 
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จิตพิสัย ปฏิบติัไดต้ามศกัยภาพท่ีมีอยู ่ตรงต่อเวลา และสนใจในการสืบคน้หาความรู้ 

ทุกช่วงโอกาสเพื่อพฒันาตนเอง5.  กจิกรรมการเรียนการสอน 

5. กจิกรรมการเรียนการสอน 

กจิกรรมครู 

ข้ันน าเข้าสู่บทเรียน (สัปดาห์ละ 30 นาท)ี 
1.  ใหค้วามร่วมมือกบัครูในการตรวจสอบ 
2. คน้ควา้เร่ือง ส่ือส่ิงพิมพ ์
3. ร่วมสนทนาและแสดงความคิดเห็น 
4. ท าแบบทดสอบก่อนเรียน 
ขั้นด าเนินการสอน (สัปดาห์ละ 180 นาท)ี 
1. ฟัง ท าความเขา้ใจและซกัถาม 
2. แบ่งกลุ่ม 
3. ฟัง ท าความเขา้ใจและปฎิบติัตาม 
4. ผูเ้รียนซกัถามขอ้สงสัยและจดบนัทึก 
5.  รับการประเมิน 
ข้ันสรุป (สัปดาห์ละ 30 นาท)ี 
1. ครูและนกัเรียนร่วมกนัสรุปสาระส าคญั 
2. นกัเรียนสอบถามขอ้สงสัย 
3. ฟังและจดบนัทึก 
4. ท าแบบฝึกหดัทา้ยบท 
5. ท าแบบทดสอบหลงัเรียน 
 

กจิกรรมนักเรียน 

ขั้นน าเข้าสู่บทเรียน (สัปดาห์ละ 30 นาท)ี 
1.  ใหค้วามร่วมมือกบัครูในการตรวจสอบ 

2. คน้ควา้เร่ือง การออกแบบส่ือส่ิงพิมพ ์

3. ร่วมสนทนาและแสดงความคิดเห็น 
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4.  ท าแบบทดสอบก่อนเรียน 

ขั้นด าเนินการสอน (สัปดาห์ละ 180 นาท)ี 
6. ฟัง ท าความเขา้ใจและซกัถาม 
7. แบ่งกลุ่ม 
8. ฟัง ท าความเขา้ใจและปฎิบติัตาม 
9. ผูเ้รียนซกัถามขอ้สงสัยและจดบนัทึก 
10.  รับการประเมิน 
ข้ันสรุป (สัปดาห์ละ 30 นาท)ี 
1. ครูและนกัเรียนร่วมกนัสรุปสาระส าคญั 

2. นกัเรียนสอบถามขอ้สงสัย 

3. ฟังและจดบนัทึก 

4. ท าแบบฝึกหดัทา้ยบท 

5. ท าแบบทดสอบหลงัเรียน 

6.  กจิกรรมการเรียนรู้ 

 ก่อนเรียน 
 คน้ควา้การออกแบบส่ือส่ิงพิมพ ์

ขณะเรียน 
1. แบ่งกลุ่มเพื่อศึกษา 
2. จดบนัทึก สาระการเรียนรู้  
3. ท าใบงาน  ตรวจสอบใบงาน แกไ้ขใบงาน 
4. ทบทวนเน้ือหา 
หลงัเรียน 

1. ร่วมกนัสรุปบทเรียน พร้อมบนัทึกผลการสรุป แลว้ลุกข้ึนน าเสนอกบัครูผูส้อน 
2. ผูเ้รียนและครูผูส้อนร่วมกนัประเมินขอ้สรุปของผูเ้รียนท่ีออกแสดงความคิดเห็นเพื่อใหไ้ดข้อ้สรุปท่ี

ถูกตอ้ง  และครูผูส้อนแสดงความช่ืนชมกบัผูเ้รียนทุกคนท่ีออกแสดงความคิดเห็นและมีส่วนร่วม
ในกิจกรรมท่ีมอบหมาย 
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3. ท าแบบฝึกหดัหลงัเรียน 
4. ร่วมกนัเฉลยแบบฝึกหดั 

 

7. ส่ือการเรียนการสอนประจ าหน่วย 

1. หนงัสือเรียนวิชา การผลิตส่ือส่ิงพิมพ ์
2. ใบความรู้ประจ าหน่วย 
3. ใบงานและแบบฝึกหดั 
4. เคร่ืองไมโครคอมพิวเตอร์ 
5. แผน่ใสและเคร่ืองฉายภาพขา้มศีรษะ 
6. ซีดีส่ือการสอน 

8. วดัผลประเมินผลประจ าหน่วย 

1. สังเกตผูเ้รียนมีความสนใจ เกิดความเขา้ใจในสาระการเรียนรู้ ตลอดจนแสดงความกระตือรือร้นใน
การแสดงความคิดเห็นและสรุปสาระการเรียนรู้ประจ าหน่วย  

2. ท าใบงานไดอ้ยา่งถูกตอ้ง  ทนัเวลาท่ีก าหนด  ใบงานสะอาดและเป็นระเบียบ 
3. ผูเ้รียนท าแบบฝึกหดัหลงัเรียนไดถู้กตอ้ง  โดยไดค้ะแนน   50%  เป็นอยา่งต ่า 

9. กจิกรรมเสนอแนะประจ าหน่วย 

1. ผูเ้รียนตอ้งใหค้วามสนใจในการศึกษา  เพื่อหาเทคนิค วธีิการ หรือหลกัการง่ายเพื่อใหห้าค าตอบได้
อยา่งถูกตอ้ง และรวดเร็ว โดยการ ตั้งใจฟังหลกัการ เทคนิควิธีการท่ีครูผูส้อนสรุปในขณะท่ีท าการ
สอน และน าขอ้สงสัยซกัถามครูในการเรียนทุกคร้ังท่ีเกิดความสับสน และไม่เขา้ใจ 

2. ผูมี้การทบทวนบทเรียน ตลอดเพื่อเสริมสร้างความเขา้ใจอยา่งแทจ้ริง 
3. ผูเ้รียนหมัน่ท าใบงาน แบบฝึกหดั และแกไ้ขขอ้ท่ีผดิใหถู้กตอ้งเสมอ 
4. ผูเ้รียนตอ้งสร้างมโนภาพให้เกิดความคิดรวบยอดในสาระการเรียนรู้และเทคนิควิธีการพร้อมกบั

ความจ าเป็นในการน าไปประยุกต์ใช้ให้เกิดข้ึนโดยตนเองให้ได้เพื่อเกิดความรู้ความเขา้ใจอย่าง
แทจ้ริงไม่ใช่เกิดจากการท่องจ า 
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เฉลยแบบฝึกหัดท้ายบทที ่2 

1. จงบอกองคป์ระกอบการออกแบบโดยสังเขป 
 การออกแบบ มอีงค์ประกอบต่างๆ ได้แก่ เส้น รูปทรง พืน้ผิว พืน้ท่ี ขนาด ความเข้มข้นและสี 
 
2. หลกัการออกแบบ มีอะไรบา้ง อธิบายพอเขา้ใจ 
  หลักการออกแบบ ได้แก่ ความสมดุล จังหวะหรือลีลา การเน้นและเอกภาพ 
การใช้เร่ืองความสมดุล (Balance) ท่ีการกระจายน า้หนักในการจัดวางองค์ประกอบในหน้างาน
ออกแบบ  

  การใช้เร่ืองจังหวะหรือลีลา (Rythm) ท่ีสร้างสรรค์องค์ประกอบท่ีซ ้าๆ กันอาศัยความหลากหลาย 

เร่ืองใช้การเน้น (Emphasis) ท่ีเกี่ยวข้องกับส่ิงท่ีต้องการให้ออกมาโดดเด่นเพ่ือการท่ีจะเห็นได้เด่นชัดก
ว่องค์ประกอบอ่ืน  

 เร่ืองความเป็นเอกภาพ (Unity) ท่ีเกี่ยวข้องกับการจัดองค์ประกอบท้ังหลาย ให้ดูเสมือนเป็นอันหน่ึงอัน
เดียวกัน หรือจัดให้เข้าด้วยกัน ประหน่ึงเป็นพวกเดียวกัน 

 
3. จงบอกเทคโนโลยเีตรียมตน้ฉบบังานพิมพ ์โดยสังเขป 

1. เคร่ืองคอมพวิเตอร์ (Computer Hardware) และชุดค าส่ัง (Computer Software) ประกอบด้วย ค าส่ัง
ระบบปฏิบัติการ (Operating System Software) ค าส่ังพืน้ฐานของระบบรับ-ส่ง (BIOS: Basic Input 
Output System)   

2. ชุดค าส่ังในการส่ือสารคนกบัเคร่ือง เช่น ดอส (DOS) ใช้ ค า พยางค์ ฯลฯ เพ่ือใช้เขยีนเป็นค าส่ัง (CUI 
: Command Line User Interface) หรือวินโดวส์  (Windows) หรือแมคอินทอช (MacIntosh) ใช้รูป  
ภาพกราฟิกแทนค าส่ัง (GUI : Graphic User Interface)   

 3. ชุดค าส่ังใช้งาน (Application Software) เช่น โปรแกรมเพ่ือใช้ออกแบบหรือจัดหน้า (Page Layout) 
ใช้เพ่ือปรับปรุงตกแต่งภาพ (Photo Retouch) ใช้เพ่ือสร้างสรรค์ภาพ อาจเป็นการวาดหรือเขยีนภาพ 
(Draw and Paint) เป็นต้น 

4. ชุดค าส่ังส าเร็จรูปตรวจทานทางภาษา การใช้โปรแกรมช่วยในการค้นหาค าและแทนท่ีค า การ
ตรวจสอบไวยากรณ์ 
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4. การเตรียมตน้ฉบบัทางการพิมพคื์ออะไร  
เป็นการจัดหน้างานพิมพ์  จัดเตรียมภาพและตรวจความถกูต้องของงานพิมพ์ก่อนส่งพิมพ์ 

5. การออกแบบหนงัสือพิมพโ์ดยทัว่ไป มีการออกแบบอะไรบา้ง ยกตวัอยา่งและอธิบาย 
(1) การสร้างสรรค์ล าดับความส าคัญโดยใช้กราฟิก เป็นการสร้างความกลมกลืนทางทัศนศิลป์ รวมท้ัง

เน้นในเร่ืองความสมดุล และการตัดกัน  
(2) รูปแบบการจัดองค์ประกอบโดยใช้กราฟิก  ได้แก่ 

ขนาดเลก็ไปหาขนาดใหญ่ เพ่ือสร้างจุดสะดุดตาอยู่ด้านล่าง ภาพประกอบขนาดเลก็จะอยู่ส่วนบน 
ดังนั้นรายละเอียดอ่ืนๆ ของกราฟิก เช่น เนือ้หาต่าง ๆ จะอยู่ตรงกลางหรือทางซ้ายขวา    

 ขนาดใหญ่ไปหาขนาดเลก็  โดยใช้ภาพขนาดใหญ่อยู่ส่วนบน เพ่ือสร้างความสนใจแก่ผู้อ่านได้ 
ส่วนรายละเอียดอ่ืนๆ กท็ านองเดียวกันจะอยู่ตรงกลางหรือด้านซ้ายขวา   

แบบแนวนอนไปหาแนวตั้ง เป็นลักษณะของการแบ่งหน้ากระดาษเป็น 2 ส่วน จะได้พืน้ท่ี
หน้ากระดาษเป็นแบบสมดุลและไม่สมดุล เม่ือจัดหน้าแบบแนวนอนไปหาแนวตั้ง ด้านบนของ
หน้ากระดาษเป็นลักษณะเปิดกว้าง และด้านล่างจะแคบเป็นแนวตั้ง 

 แบบแนวตั้งไปหาแนวนอน เป็นการออกแบบจัดหน้าตรงข้าม โดยด้านบนของหน้ากระดาษจะเป็น
การแบ่งเป็นแท่งแนวตั้ง ส่วนด้านล่างจะเป็นเนือ้ท่ีกว้าง ผู้อ่านจะถกูก าหนดให้อ่านจากซ้ายไปขวา   

(3) การออกแบบจัดวางต าแหน่งช่ือหนังสือพิมพ์ ควรจะท าให้น่าประทับใจ เรียบง่าย มีความน่าอ่าน 
บริเวณช่ือหนังสือพิมพ์ ควรใช้พืน้ท่ีขาวหรือว่างขาวรอบช่ือหนังสือพิมพ์  ช่ือหนังสือพิมพ์ควรอยู่
ด้านบนสุดของหน้าหนังสือพิมพ์ และควรใช้ขนาดความยาวตลอดท้ังหน้า คือ ใช้พืน้ท่ีให้กว้างจาก
ซ้ายตลอดไปทางขวามือ เช่น ถ้าหนังสือพิมพ์กว้าง 8 คอลัมน์ ควรวางช่ือหนังสือพิมพ์ตลอด 8 
คอลัมน์  แต่บางฉบับใช้เพียง 2, 3 หรือ 4 คอลัมน์กไ็ด้ส่วนท่ีเหลือเป็นพืน้ท่ีว่าง 

(4) การออกแบบต าแหน่งค าอธิบายภาพ โดยส่วนใหญ่แล้วจะใช้ 2 บรรทัด นอกจากภาพประกอบท่ี
ขนาดใหญ่ ซ่ึงบรรจุลงในเนือ้ท่ีมากกว่า 3 คอลัมน์  ค าอธิบายภาพอาจแบ่งเป็น 2 หรือมากกว่า 2 
คอลัมน์ การใช้ค าอธิบายภาพกับต าแหน่งของภาพควรวางให้ใกล้เคียงกัน ค าอธิบายภาพท่ีดี ควร
วางใต้ภาพ หรืออาจะเป็นด้านซ้าย หรือด้านขวาของภาพ เม่ือใช้ภาพมากกว่า 1 ภาพ ควรแยก
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ค าอธิบายแต่ละภาพ ซ่ึงผู้ อ่านจะได้รับรู้ค าอธิบายอย่างทันทีทันใดเกี่ยวกับภาพนั้น โดยไม่
จ าเป็นต้องกวาดสายตาไปหาอีกให้เสียเวลา 

(5) การออกแบบวางต าแหน่งช่ือผู้เขยีน โดยปกติจะอยู่ระหว่างพาดหัวข่าว และวรรคน า แต่หนังสือพิมพ์
ในประเทศไทยส่วนใหญ่ยงัไม่มกีารระบุช่ือ ผู้ เขยีน หรือผู้ ส่ือข่าว แต่มแีนวโน้มว่าต่อไปจ าเป็นต้อง
มกีารระบุ ท้ังนีเ้พ่ือเป็นการสร้างความน่าเช่ือถือของข่าว ว่าข่าวนั้นบุคคลใดเป็นผู้รายงานข่าว 
เพราะช่ือเสียงเกียรติประวติั  การรายงานข่าวจะท าให้ผู้อ่านมคีวามศรัทธาเช่ือถือเอง 

 (6) การออกแบบวางต าแหน่งช่ือผู้เขยีน  ได้แก่  

 ต้นฉบับยาวและการออกแบบแนวนอน เม่ือต้นฉบับมีความยาว ควรใช้การออกแบบแนวนอน จะ
เหมาะสมกว่าแนวด่ิง เพราะว่าถ้าใช้แนวด่ิงท าให้รู้สึกว่ายาว ไม่น่าอ่าน ผิดกับจัดแนวนอน
ความรู้สึกว่าส้ันกว่า 

 ต้นฉบับยาวและการใช้ขนาดคอลัมน์กว้าง ต้นฉบับท่ียาว หากใช้คอลัมน์ขนาดกว้าง จะใช้เนือ้ท่ี
น้อยกว่าคอลัมน์แคบ และผู้อ่านมคีวามอยากอ่านคอลัมน์ขนาดกว้างมากกว่าคอลัมน์แคบ 

 ต้นฉบับยาวและการใช้การพักสายตา ต้นฉบับท่ียาว จะท าให้เกิดพืน้ท่ีสีเทามากขึน้ ควรใช้ส่ิงท่ีหยดุ
ให้พักสายตา ได้แก่ การใช้ “อัญพจน์”  โดยอ้างบางส่วนจากเนือ้หา มาใส่ในอัญประกาศ  ซ่ึงอาจ
วางไว้ตรงกลางคอลัมน์ หรือใต้หัวเร่ือง หรืออาจวางไว้เหนือหัวเร่ืองด้านซ้าย หรือขวาได้ 
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แผนจัดการเรียนรู้   หน่วยที3่ 

รายวชิา    การผลิตส่ือส่ิงพิมพ ์ สอนคร้ังที ่3 

ช่ือเร่ือง   กระบวนการพิมพ ์  จ านวน  4 ช่ัวโมง 

 

1. สาระส าคัญ 
ในบทน้ี เราจะเรียนรู้ถึงกระบวนการพิมพ ์ตั้งแต่การจดัเตรียมงานพิมพ ์ไปจนถึงการท าแม่แบบการ

พิมพ ์และการเขา้เล่มในตอนจบงานพิมพ ์ซ่ึงกระบวนการท่ีอยูใ่นโรงพิมพน์ั้นเราไม่สามารถเขา้ไปดูแลได้

ทั้งหมด แต่ส าหรับนกัออกแบบกราฟิก จะตอ้งติดต่อประสานงานกบัโรงพิมพ ์ไดแ้ก่ การส่งไฟลง์านพิมพ ์การ

ตรวจงานพิมพห์ลงัจากสร้างแม่พิมพเ์สร็จแลว้ก่อนข้ึนแท่นพิมพง์านทั้งหมด และตรวจการเรียงหนา้ก่อนเขา้เล่ม 

ซ่ึงจะแตกต่างกนัตามชนิดของงานพิมพ ์

2 . จุดประสงค์การเรียนรู้ 

1. มีความรู้ และอธิบายจ าแนกการเตรียมตน้ฉบบัก่อนการพิมพไ์ด ้

2. มีความรู้ และอธิบายถึงบริบทเก่ียวกบัตวัพิมพไ์ด ้

3. มีความรู้ และอธิบายถึงประเภทของสีได ้

4. มีความรู้ และอธิบายขั้นตอนและวธีิการแยกสีได ้

5. มีความรู้ และอธิบายประเภทระบบการพิมพไ์ด ้

6. มีความรู้ และอธิบายบริบทเก่ียวหมึกพิมพไ์ด ้

7. มีความรู้ และอธิบายจ าแนกประเภทกระดาษ 

8. มีความรู้ และอธิบายถึงขั้นตอนการท างานใหแ้ลว้เสร็จได ้

3. สาระการเรียนรู้ 

1. การเตรียมตน้ฉบบัก่อนการพิมพ ์
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2. ตวัพิมพ ์

3. พื้นฐานทางสี 

4. การแยกสี 

5. ระบบการพิมพ ์ 6. หมึกพิมพ ์

7. กระดาษ    8. การท าใหแ้ลว้เสร็จ 

4. การวดัประเมินผล 

ทกัษะพิสัย  มีกระบวนการวางแผน และปฏิบติัไดต้รงตามเป้าหมายท่ีก าหนด 

พุทธิพิสัย มีความจ า ความเขา้ใจ และการน าไปประยกุตใ์ห้เกิดประโยชน์ต่อการเรียน 

หรือการใชชี้วติประจ าวนั 

จิตพิสัย ปฏิบติัไดต้ามศกัยภาพท่ีมีอยู ่ตรงต่อเวลา และสนใจในการสืบคน้หาความรู้ 

ทุกช่วงโอกาสเพื่อพฒันาตนเอง 

5.  กจิกรรมการเรียนการสอน 

กจิกรรมครู 

ข้ันน าเข้าสู่บทเรียน (สัปดาห์ละ 30 นาท)ี 
1.  ใหค้วามร่วมมือกบัครูในการตรวจสอบ 
2. คน้ควา้เร่ือง ส่ือส่ิงพิมพ ์
3. ร่วมสนทนาและแสดงความคิดเห็น 
4. ท าแบบทดสอบก่อนเรียน 
ขั้นด าเนินการสอน (สัปดาห์ละ 180 นาท)ี 
6. ฟัง ท าความเขา้ใจและซกัถาม 
7. แบ่งกลุ่ม 
8. ฟัง ท าความเขา้ใจและปฎิบติัตาม 
9. ผูเ้รียนซกัถามขอ้สงสัยและจดบนัทึก 
10.  รับการประเมิน 
ข้ันสรุป (สัปดาห์ละ 30 นาท)ี 
6. ครูและนกัเรียนร่วมกนัสรุปสาระส าคญั 
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7. นกัเรียนสอบถามขอ้สงสัย 
8. ฟังและจดบนัทึก 
9. ท าแบบฝึกหดัทา้ยบท 
10. ท าแบบทดสอบหลงัเรียน 

 

กจิกรรมนักเรียน 

ข้ันน าเข้าสู่บทเรียน (สัปดาห์ละ 30 นาท)ี 
1.  ใหค้วามร่วมมือกบัครูในการตรวจสอบ 

2. คน้ควา้เร่ือง การออกแบบส่ือส่ิงพิมพ ์

3. ร่วมสนทนาและแสดงความคิดเห็น 

4.  ท าแบบทดสอบก่อนเรียน 

ขั้นด าเนินการสอน (สัปดาห์ละ 180 นาท)ี 
11. ฟัง ท าความเขา้ใจและซกัถาม 
12. แบ่งกลุ่ม 
13. ฟัง ท าความเขา้ใจและปฎิบติัตาม 
14. ผูเ้รียนซกัถามขอ้สงสัยและจดบนัทึก 
15.  รับการประเมิน 
ข้ันสรุป (สัปดาห์ละ 30 นาท)ี 
1. ครูและนกัเรียนร่วมกนัสรุปสาระส าคญั 

2. นกัเรียนสอบถามขอ้สงสัย 

3. ฟังและจดบนัทึก 

4. ท าแบบฝึกหดัทา้ยบท 

5. ท าแบบทดสอบหลงัเรียน 

6.  กจิกรรมการเรียนรู้ 

 ก่อนเรียน 
 คน้ควา้กระบวนการพิมพ ์
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ขณะเรียน 
5. แบ่งกลุ่มเพื่อศึกษา 
6. จดบนัทึก สาระการเรียนรู้  
7. ท าใบงาน  ตรวจสอบใบงาน แกไ้ขใบงาน 
8. ทบทวนเน้ือหา 
หลงัเรียน 

5. ร่วมกนัสรุปบทเรียน พร้อมบนัทึกผลการสรุป แลว้ลุกข้ึนน าเสนอกบัครูผูส้อน 
6. ผูเ้รียนและครูผูส้อนร่วมกนัประเมินขอ้สรุปของผูเ้รียนท่ีออกแสดงความคิดเห็นเพื่อใหไ้ดข้อ้สรุปท่ี

ถูกตอ้ง  และครูผูส้อนแสดงความช่ืนชมกบัผูเ้รียนทุกคนท่ีออกแสดงความคิดเห็นและมีส่วนร่วม
ในกิจกรรมท่ีมอบหมาย 

7. ท าแบบฝึกหดัหลงัเรียน 
8. ร่วมกนัเฉลยแบบฝึกหดั 

 

7. ส่ือการเรียนการสอนประจ าหน่วย 

7. หนงัสือเรียนวิชา การผลิตส่ือส่ิงพิมพด์ว้ยคอมพิวเตอร์ 
8. ใบความรู้ประจ าหน่วย 
9. ใบงานและแบบฝึกหดั 
10. เคร่ืองไมโครคอมพิวเตอร์ 
11.  แผน่ใสและเคร่ืองฉายภาพขา้มศีรษะ 
12. ซีดีส่ือการสอน 

 

8. วดัผลประเมินผลประจ าหน่วย 

4. สังเกตผูเ้รียนมีความสนใจ เกิดความเขา้ใจในสาระการเรียนรู้ ตลอดจนแสดงความกระตือรือร้นใน
การแสดงความคิดเห็นและสรุปสาระการเรียนรู้ประจ าหน่วย  

5. ท าใบงานไดอ้ยา่งถูกตอ้ง  ทนัเวลาท่ีก าหนด  ใบงานสะอาดและเป็นระเบียบ 
6. ผูเ้รียนท าแบบฝึกหดัหลงัเรียนไดถู้กตอ้ง  โดยไดค้ะแนน   50%  เป็นอยา่งต ่า 
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9. กจิกรรมเสนอแนะประจ าหน่วย 

5. ผูเ้รียนตอ้งใหค้วามสนใจในการศึกษา  เพื่อหาเทคนิค วธีิการ หรือหลกัการง่ายเพื่อใหห้าค าตอบได้
อยา่งถูกตอ้ง และรวดเร็ว โดยการ ตั้งใจฟังหลกัการ เทคนิควิธีการท่ีครูผูส้อนสรุปในขณะท่ีท าการสอน และน า
ขอ้สงสัยซกัถามครูในการเรียนทุกคร้ังท่ีเกิดความสับสน และไม่เขา้ใจ 

6. ผูมี้การทบทวนบทเรียน ตลอดเพื่อเสริมสร้างความเขา้ใจอยา่งแทจ้ริง 
7. ผูเ้รียนหมัน่ท าใบงาน แบบฝึกหดั และแกไ้ขขอ้ท่ีผดิใหถู้กตอ้งเสมอ 
8. ผูเ้รียนตอ้งสร้างมโนภาพให้เกิดความคิดรวบยอดในสาระการเรียนรู้และเทคนิควิธีการพร้อมกบั

ความจ าเป็นในการน าไปประยุกตใ์ชใ้ห้เกิดข้ึนโดยตนเองให้ไดเ้พื่อเกิดความรู้ความเขา้ใจอยา่งแทจ้ริงไม่ใช่เกิด
จากการท่องจ า 

 
เฉลยแบบฝึกหัด หน่วยที ่3 

     1.  การเตรียมตน้ฉบบัก่อนการพิมพ ์มีอะไรบา้ง 
1. การเตรียมต้นฉบับภาพ 
2. การเตรียมต้นฉบับตัวหนังสือ 
3. การถ่ายภาพการพิมพ์   
4. การประกอบหน้า 
 

2.  ตวัพิมพภ์าษาไทยและภาษาองักฤษ มีความเหมือน และ/หรือต่างกนั หรือไม่ อยา่งไรอธิบาย 
 
 โครงสร้างตัวพิมพ์จะมแีตกต่างกันระหว่างตัวพิมพ์ภาษาอังกฤษกับตัวพิมพ์ภาษาไทย ดงันี ้
 ภาษาอังกฤษ แบ่งตัวอักษรเป็น 3 ระดับ ได้แก่  

 1.  ระดับบนสุด เป็นระดับอักษรตัวพิมพ์เลก็ท่ีมเีส้นหางบน เช่น  b d t h k l t ฯลฯ 

 2.  ระดับกลาง  เป็นระดับ อักษรตัวพิมพ์เลก็ท่ีไม่มเีส้นหางบนหรือหางล่าง   เช่น  a c e m n o ฯลฯ 

 3.  ระดับล่าง  เป็นระดับตัว อักษรตัวพิมพ์เลก็ท่ีมเีส้นหางล่าง เช่น p q y ฯลฯ ส่วนตัวอักษรตัวพิมพ์
ใหญ่มรีะดับเดียวกันหมด  

 ภาษาไทย แบ่งตัวอักษรเป็น 4 ระดับ ได้แก่  
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 1.  ระดับบนสุด  เป็นระดับวรรณยกุต์ เช่น  ่่   ่้    ่    ่   ฯลฯ  

2.  ระดับพยญัชนะท่ีมหีางบน ระดับสระอยู่ด้านบน และสระท่ีมหีางบน เช่น ช ซ ป ฝ ฟ ศ ศ ส ฬ ฮ โ ไ ใ    
่ิ    ่ี    ่ึ    ่ื ฯลฯ  

 3.  ระดับพยญัชนะและสระท่ีเสมอบรรทัด หรือไม่มหีางบนหรือล่าง เช่น ก ข ค ง ะ า เ  แ ฯลฯ  

 4.  ระดับพยญัชนะท่ีมหีางล่างและสระท่ีอยู่ด้านล่าง เช่น ญ ฎ ฐ   ุ่   ู่ ฯลฯ 

 

3.  สี มีก่ีประเภท อะไรบา้ง สีในการพิมพ ์คือ ประเภทใด 
 สีม ี2 ประเภท ได้แก่  แม่สีบวกและแม่สีลบ สีท่ีใช้ในการพิมพ์ คือ สีลบ 

 

4. จงบอกขั้นตอนและวธีิการแยกสีท่ีจะท าแม่พิมพ ์ทั้ง 4 สีอยา่งละเอียด 
 ในการแยกสีจะอาศัยหลักการผสมสีท้ังแม่สีบวกและแม่สีลบ มาประยกุต์เป็นแว่นกรองแสง เพ่ือเป็นแว่น
กรองสี และมมุเมด็สกรีน โดยการถ่ายฟิล์มนั้น จะต้องท าการถ่าย 4 คร้ัง ดังนี ้  

1. ถ่ายคร้ังท่ี 1 เพ่ือให้ได้ฟิล์มส าหรับแม่พิมพ์สีเหลือง (Yellow plate) ให้ใช้แว่นสีน า้เงิน (Blue filter) 
และใช้มมุของเมด็สกรีน 10 องศา 

2. ถ่ายคร้ังท่ี 2 เพ่ือให้ได้ฟิล์มส าหรับแม่พิมพ์สีบานเยน็ (Magenta plate) ให้ใช้แว่นสีเขยีว (Green 
filter) และใช้มมุของเมด็สกรีน 75 องศา 

3. ถ่ายคร้ังท่ี 3 เพ่ือให้ได้ฟิล์ม ส าหรับสีฟ้า (Cyan plate) ให้ใช้แว่นสีแดง (Red filter) และใช้มมุของ
เมด็สกรีน 105 องศา 

4. ถ่ายคร้ังท่ี 4 เพ่ือให้ได้ฟิล์ม ส าหรับสีด าให้ (  ่ Black plate) ใช้แว่นทุกสีพร้อมกัน และมมุของเมด็
สกรีน 45 องศา 

  

5. ระบบการพิมพมี์อะไรบา้ง 
การพิมพ์แม่พิมพ์พืน้นูน (Letter press), การพิมพ์แม่พิมพ์พืน้ลึก, การพิมพ์แม่พิมพ์พืน้ราบ, การพิมพ์
แม่พิมพ์พืน้ฉลุ  และการพิมพ์ไร้แรงกด   
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6. หมึกพิมพมี์คุณสมบติัอะไรบา้ง มีการแหง้ก่ีแบบ 
คุณสมบัติของหมึกพิมพ์มี 3 ประการ ได้แก่ ความเหนียว (Viscosity) , การติดแน่น (Tack)  และลักษณะ
การแห้ง (Drying quality) 

 การแห้งม ี 4 วิธี ได้แก่  

 การระเหย (Evaporation) ส่วนมากใช้หมึกเหลวและจางในการพิมพ์กราเวยีร์เพ่ือให้หมึกแห้งเร็ว  

การอบด้วยสารเคมี (Chemical curing) การเติมสารเร่งปฏิกิริยาทางเคมเีข้าในหมึกก่อนเร่ิมพิมพ์ มวิีธีอบ
ท่ีคล้ายกัน คือ อบด้วยแสงอุลต้าไวโอเลต (Ultraviolet light)  

การซึมซับ (Penetration) เป็นหมึกพิมพ์กับกระดาษท้ังหลายท่ีดูดซึมซับได้ดี แต่ไม่เหมาะกับการพิมพ์
บนขวด พลาสติก หรือฟอยด์  

การจับก้อนด้วยการอ๊อกซิเดชัน (oxidation) เป็นการแห้งด้วยการดูดอากาศออกซิเจนเข้ามาจะท าให้อนู
ของหมึกจับกันเป็นก้อนแขง็ เพ่ือยึดติดกับวสัดุท่ีพิมพ์ แต่เป็นกระบวนท่ีเป็นไปอย่างช้า ๆ  

 

7. กระดาษมีการพิจารณาความหนาอยา่งไร 
ใช้น า้หนักเป็นตัวบ่งชีค้วามหนา ถ้าน า้หนักมาก หมายถึง กระดาษมคีวามหนามาก กล่าวคือ ใช้กระดาษ
ขนาดหน่ึงตารางเมตร ช่ังดูว่าหนักท่าไร เช่น น า้หนัก 70 กรัม 80 กรัม แสดงว่ากระดาษ 80 กรัมหนา
กว่า 70 กรัมเพราะน า้หนักมากกว่า 

 

8. ขั้นตอนการท างานพิมพใ์ห้แลว้เสร็จ มีอะไรบา้ง 
 เป็นขัน้ตอนสุดท้ายในการปิดงาน ได้แก่ การพับ การเข้าเล่ม การเยบ็เล่มและการเข้าปก 
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แผนจัดการเรียนรู้   หน่วยที3่ 

รายวชิา    การผลิตส่ือส่ิงพิมพ ์ สอนคร้ังที ่3 

ช่ือเร่ือง   รู้จกักบัโปรแกรม InDesign                  จ านวน  4 ช่ัวโมง 

 

1.  สาระส าคัญ 

งานดา้นส่ือส่ิงพิมพต่์างๆ เช่น นิตยสาร วารสาร โบรชวัร์หรือแผน่พบั และหนงัสือประเภทต่างๆ ท่ีมีอยูใ่น
ปัจจุบนันั้น มีความเก่ียวขอ้งกบัโปรแกรม Adobe InDesign ซ่ึงเป็นโปรแกรมท่ีสามารถออกแบบและสร้างสรรค์
ผลงานส่ิงพิมพเ์หล่าน้ีไดอ้ยา่งรวดเร็วและมีประสิทธิภาพ 

  
2. ผลการเรียนรู้ทีค่าดหวงั 

1. รู้และเขา้ใจในโปรแกรม Adobe InDesign 
2. อธิบายการเขา้สู่โปรแกรม Adobe InDesign ได ้
3. อธิบายเก่ียวกบัแถบค าสั่งของโปรแกรม Adobe InDesign ได ้
4. อธิบายเก่ียวกบักล่องเคร่ืองมือของโปรแกรม Adobe InDesign ได ้
5. อธิบายเก่ียวกบัคอนโทรลพาเนลของโปรแกรม Adobe InDesign ได ้
6. อธิบายเก่ียวกบัพาเนลควบคุมการท างานได ้
7. สามารถจดัการกบัหนา้ต่างการท างานได ้
8. สามารถก าหนดคียล์ดัได ้
9. อธิบายเก่ียวกบัโปรแกรมช่วยจดัการขอ้ความภาษาไทยได ้
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3.  กจิกรรมการเรียนรู้ 

กจิกรรมครู 

ขั้นน าเข้าสู่บทเรียน (สัปดาห์ละ 30 นาท)ี 
1.  ใหค้วามร่วมมือกบัครูในการตรวจสอบ 
2. คน้ควา้เร่ือง ส่ือส่ิงพิมพ ์
3. ร่วมสนทนาและแสดงความคิดเห็น 
4. ท าแบบทดสอบก่อนเรียน 
ขั้นด าเนินการสอน (สัปดาห์ละ 180 นาท)ี 
11. ฟัง ท าความเขา้ใจและซกัถาม 
12. แบ่งกลุ่ม 
13. ฟัง ท าความเขา้ใจและปฎิบติัตาม 
14. ผูเ้รียนซกัถามขอ้สงสัยและจดบนัทึก 
15.  รับการประเมิน 
ข้ันสรุป (สัปดาห์ละ 30 นาท)ี 
11. ครูและนกัเรียนร่วมกนัสรุปสาระส าคญั 
12. นกัเรียนสอบถามขอ้สงสัย 
13. ฟังและจดบนัทึก 
14. ท าแบบฝึกหดัทา้ยบท 
15. ท าแบบทดสอบหลงัเรียน 

 

กจิกรรมนักเรียน 

ข้ันน าเข้าสู่บทเรียน (สัปดาห์ละ 30 นาท)ี 
1.  ใหค้วามร่วมมือกบัครูในการตรวจสอบ 

2. คน้ควา้เร่ือง การออกแบบส่ือส่ิงพิมพ ์

3. ร่วมสนทนาและแสดงความคิดเห็น 
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4.  ท าแบบทดสอบก่อนเรียน 

ขั้นด าเนินการสอน (สัปดาห์ละ 180 นาท)ี 
16. ฟัง ท าความเขา้ใจและซกัถาม 
17. แบ่งกลุ่ม 
18. ฟัง ท าความเขา้ใจและปฎิบติัตาม 
19. ผูเ้รียนซกัถามขอ้สงสัยและจดบนัทึก 
20.  รับการประเมิน 
ข้ันสรุป (สัปดาห์ละ 30 นาท)ี 
1. ครูและนกัเรียนร่วมกนัสรุปสาระส าคญั 

2. นกัเรียนสอบถามขอ้สงสัย 

3. ฟังและจดบนัทึก 

4. ท าแบบฝึกหดัทา้ยบท 

5. ท าแบบทดสอบหลงัเรียน 

4.   กจิกรรมการเรียนรู้ 

 ก่อนเรียน 
1. คน้ควา้ค าเก่ียวกบัความสามารถโดยรวมของโปรแกรม  InDesign 
 ขณะเรียน 

1. ท าความเขา้ใจและปฎิบติัตามในแต่ละหวัขอ้การเรืยน 

2. ท าใบงานและแบบฝึกหดัหลงัเรียน 

3. ร่วมกนัเฉลยใบงานและแบบฝึกหดัหลงัเรียน 

4. จดบนัทึก เทคนิค แนวการท่ีเป็นประโยชน์ต่อผูเ้รียน จากขอ้แนะน าของครูผูส้อน 

5. ผูเ้รียนสรุปความรู้ท่ีไดจ้ากการเรียนตามความเป็นจริง จากภูมิความรู้ของผูเ้รียนแต่ละคน 

6. ผูเ้รียนซกัถามในหวัขอ้ท่ีสงสัยในเน้ือหาการเรียนรู้ 

 

5.  ส่ือการเรียนการสอน 
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1. หนงัสือประกอบการเรียนวชิา การผลิตส่ือส่ิงพิมพ ์    

2. แฟ้มสะสมผลงาน   

3. ใบความรู้ประจ าหน่วย 

4. เคร่ืองไมโครคอมพิวเตอร์ 

5. แผน่ใสและเคร่ืองฉายภาพขา้มศีรษะ 

6. ซีดีส่ือการสอนเร่ืองระบบฐานขอ้มูล 

 

6. วดัผลประเมินผล 

1. ผูเ้รียนปฏิบติัภาระงานท่ีมอบหมายเสร็จทนัเวลาท่ีก าหนด 

2. ตอบค าถามและสรุปผลงานไดอ้ยา่งถูกตอ้ง 

3. ท าแบบฝึกหดัหลงัเรียนเสร็จทนัเวลาท่ีก าหนดและถูกตอ้ง  

4. สนใจกระตือรือร้นในการเรียนรู้ ตอบค าถาม สรุปสาระการเรียนรู้ และกลา้แสดงความคิดเห็น 

 

7.   กจิกรรมเสนอแนะ 

ถา้ผูเ้รียนมีการเตรียมตวัในการเรียนท่ีดี เช่น อ่าน และท าการศึกษาหนงัสือเก่ียวกบัหน่วยการเรียนมาก
ก่อน ถึงชั่วโมงเรียน ผูเ้รียน จะสามารถเรียน และท ากิจกรรมต่าง ๆ ท่ีครูผูส้อนมอบหมาย ไดอ้ย่างมีความสุข 
และเกิดความชอบ และสนุกกบัการเรียนในชั้นเรียน 

 

เฉลยแบบฝึกหัดหน่วยที ่ 4 

ตอนท่ี 1 จงตอบค าถามต่อไปน้ี 

1. การเตรียมเคร่ืองคอมพิวเตอร์เพื่อติดตั้งโปรแกรม InDesign มีอะไรบา้ง 

1.  ซีพีย ูIntel Pentium 4, Intel Core Duo หรือมคุีณสมบัติเทียบเท่า 

2.  ระบบปฏิบัติการ Windows XP  Service Pack 2 ขึน้ไป หรือ Windows 7 



33 
 

3.  หน่วยความจ า 512 MB ขึน้ไปส าหรับ Windows XP และ 1 GB ขึน้ไปส าหรับ Windows 7 

4.  พืน้ท่ีบนฮาร์ดดิสก์ 1.8 GB ส าหรับการติดตั้งโปรแกรม (เพ่ือประสิทธิภาพการท างานท่ีดีขึน้ควรมพืีน้ท่ี 

     4 GB ขึน้ไป) 

 

2. Menu Bar ในโปรแกรม InDesign มีอะไรบา้ง จงอธิบายมาพอเขา้ใจ 

 file เป็นค าส่ังการท างานเกี่ยวกับไฟล์ เช่น การเปิดไฟล์ (Open), ปิดไฟล์ (Close),  การบันทึกไฟล์  

  (Save) นอกจากนีย้งัเกี่ยวข้องกับการน าไฟล์เข้ามาใช้ (Place) และก าหนดคุณสมบัติของไฟล์  

  (Document Setup) 

 Edit เป็นค าส่ังเกี่ยวกับการปรับแต่งต่างๆ เช่น การย้อนกลับการท างาน (Undo/Redo), การตัด (Cut),  

  การท าส าเนาหรือคัดลอก (Copy), การวาง (Paste) และการก าหนดค่าการท างานพืน้ฐานของ 

  โปรแกรม (Preference)   

 Layout เป็นค าส่ังท่ีเกี่ยวกับการวางหน้าเอกสารท้ังหมด เช่น เพ่ิมหน้าเอกสาร (Add Page), ก าหนด 

  ระยะเส้นไกด์ และจัดคอลัมน์ (Magins & Columns), เล่ือนไปยงัหน้าต่างๆ (Go to page),  

  การก าหนดเลขหน้า (Numbering & Section options) 

 Type เป็นค าส่ังท่ีเกี่ยวกับการท างานกับตัวอักษร  

Object เป็นค าส่ังเกี่ยวกับการจัดการออบเจก็ต์ท้ังหมด เช่น ค าส่ังในการจัดกลุ่ม (Group), การจัดล าดับ  

 (Arrange) และการปรับแต่ง (Transform) รวมไปถึงการใส่เอฟเฟ็กต์เพ่ิมเติม 

 Table  เป็นค าส่ังเกี่ยวกับการใช้งานตาราง ตั้งแต่การสร้าง และการปรับแต่งรูปแบบของตาราง 

 View  ก าหนดมมุมองการแสดงภาพในรูปแบบต่างๆ เช่น การขยายดูภาพใกล้ๆ  

 Window จัดการแต่ละหน้าต่างท่ีปรากฏบนหน้าจอของโปรแกรม เพ่ือช่วยให้ท างานได้สะดวกขึน้ 

 Help  รวบรวมวิธีการใช้งานและค าแนะน าเกี่ยวกับโปรแกรม Adobe InDesign 

 

3. จงอธิบายวธีิการสร้างและลบคียล์ดัมาพอเขา้ใจ 
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วิธีการสร้างคีย์ลัด 

1. เลือกค าส่ัง Edit->Keyboard Shortcuts... 

2. สร้างชุดคีย์ลัดขึน้มาใหม่ โดยคลิกปุ่ม New Set... 

3. ตั้งช่ือให้กับชุดคีย์ลัดใหม่ท่ีสร้างในช่อง Name และเลือกก าหนดชุดคีย์ลัดอ้างอิงท่ี Based on Set เพ่ือใช้ 

  เป็นคีย์ลัดต้นแบบของคีย์ลัดท่ีเราสร้างขึน้ 

4. คลิกปุ่ม OK ช่ือของชุดคีย์ลัดท่ีสร้างจะปรากฏอยู่ ท่ีหัวข้อ Set ในหน้าต่าง Keyboard Shortcuts 

5. เลือกค าส่ังท่ีต้องการสร้างคีย์ลัดท่ีช่อง Command ซ่ึงจะปรากฏคีย์ลัดเดิมท่ีช่อง Current Shotcuts  

6. คลิกเมาส์เลือกท่ี New Shortcut และกดคีย์ท่ีต้องการตั้งเป็นคีย์ลัด ตัวอย่างก าหนดเป็นปุ่ม 1 

7. เม่ือก าหนดคีย์ลัดต่างๆ เรียบร้อยคลิกปุ่ม OK เพ่ือตกลงใช้งานตามค่าท่ีตั้งไว้ 

วิธีการลบคีย์ลัด 

1. เลือกค าส่ัง Edit->Keyboard Shortcuts... 

2. คลิกเลือกช่ือของชุดคีย์ลัดท่ีต้องการลบ 

3. คลิกเมาส์ท่ีปุ่ม Delete Set 

4. ปรากฏหน้าต่างถามว่า ต้องการลบคีย์ลัดท่ีเราเลือกไว้หรือไม่ คลิกท่ี Yes 

 

4. การใชง้านโปรแกรม Kokai ร่วมกบั InDesign มีขั้นตอนอยา่งไร จงอธิบาย 

1.ดับเบิล้คลิกท่ีไอคอนโปรแกรม Kokai บนหน้าเดสก์ทอ็ป เพ่ือเปิดใช้งานโปรแกรมก่อนท่ีจะเปิด 

  โปรแกรม InDesign 

2. เปิดโปรแกรม InDesign ขึน้มา โปรแกรม Kokai จะท างานร่วมกับ InDesign ทันที เพ่ือช่วยในการตัดค า  

   และแก้ปัญหาสระลอยในการใช้งานตัวอักษรภาษาไทย  

3. เม่ือต้องการเลิกใช้งานโปรแกรม ต้องปิดโปรแกรม InDesign ก่อนท่ีจะปิดโปรแกรม Kokai ทุกคร้ัง                 
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5. จงบอกส่วนประกอบของหนา้จอโปรแกรม InDesign 

 

5.1 คือ สัญลักษณ์ของโปรแกรม InDesign 

5.2 คือ แถบค าส่ัง (Menu Bar) 

5.3 คือ แถบคอนโทรลพาเนล (Control Panel) 

5.4 คือ พาเนลต่างๆ (Dock Panel) ท่ีรวบรวมคุณสมบัติการท างาน 

5.5 คือ กล่องเคร่ืองมือ (Tool Box) 
5.6 คือ พืน้ท่ีการท างาน (Art Board) 
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แผนจัดการเรียนรู้   หน่วยที ่6 

รายวชิา    การผลิตส่ือส่ิงพิมพ ์ สอนคร้ังที ่6 

ช่ือเร่ือง   การจดัการไฟลง์านและเคร่ืองมือพื้นฐาน                  จ านวน  4 ช่ัวโมง 

 
1.  สาระส าคัญ 

 เป็นการเรียนรู้เก่ียวกบัการจดัการกบัช้ินงาน ตั้งแต่ขั้นตอนในการสร้างไฟลง์าน, การเปิดไฟลง์าน, การ
บนัทึกไฟลง์าน และการปิดไฟลง์าน รวมถึงการเพิ่ม และการลดจ านวนหนา้ ซ่ึงเป็นการจดัการขั้นพื้นฐานกบั
ไฟลง์าน 

  
 
2. ผลการเรียนรู้ทีค่าดหวงั 

1. อธิบายเก่ียวกบัเร่ืองการสร้างไฟลง์านได ้
2. สามารถบนัทึกไฟลง์านได ้
3. อธิบายเก่ียวกบัการปิดไฟลง์านได ้
4. สามารถเปิดไฟลง์านเดิมได ้
5. สามารถเพิ่มและลดจ านวนหนา้ได ้
6. สามารถท าการยา้ยหนา้กระดาษได ้
7. อธิบายการยอ่และขยายมุมมองได ้
8. สามารถใชค้  าสั่งยกเลิก Undo/Revert ได ้
9.   อธิบายการใชง้านเคร่ืองมือวดัได ้

3.  กจิกรรมการเรียนรู้ 
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กจิกรรมครู 

ข้ันน าเข้าสู่บทเรียน (สัปดาห์ละ 30 นาท)ี 
1.  ใหค้วามร่วมมือกบัครูในการตรวจสอบ 
2. คน้ควา้เร่ือง ส่ือส่ิงพิมพ ์
3. ร่วมสนทนาและแสดงความคิดเห็น 
4. ท าแบบทดสอบก่อนเรียน 
ขั้นด าเนินการสอน (สัปดาห์ละ 180 นาท)ี 
16. ฟัง ท าความเขา้ใจและซกัถาม 
17. แบ่งกลุ่ม 
18. ฟัง ท าความเขา้ใจและปฎิบติัตาม 
19. ผูเ้รียนซกัถามขอ้สงสัยและจดบนัทึก 
20.  รับการประเมิน 
ข้ันสรุป (สัปดาห์ละ 30 นาท)ี 
16. ครูและนกัเรียนร่วมกนัสรุปสาระส าคญั 
17. นกัเรียนสอบถามขอ้สงสัย 
18. ฟังและจดบนัทึก 
19. ท าแบบฝึกหดัทา้ยบท 
20. ท าแบบทดสอบหลงัเรียน 

 

กจิกรรมนักเรียน 

ข้ันน าเข้าสู่บทเรียน (สัปดาห์ละ 30 นาท)ี 
1.  ใหค้วามร่วมมือกบัครูในการตรวจสอบ 

2. คน้ควา้เร่ือง การออกแบบส่ือส่ิงพิมพ ์

3. ร่วมสนทนาและแสดงความคิดเห็น 

4.  ท าแบบทดสอบก่อนเรียน 

ขั้นด าเนินการสอน (สัปดาห์ละ 180 นาท)ี 
21. ฟัง ท าความเขา้ใจและซกัถาม 
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22. แบ่งกลุ่ม 
23. ฟัง ท าความเขา้ใจและปฎิบติัตาม 
24. ผูเ้รียนซกัถามขอ้สงสัยและจดบนัทึก 
25.  รับการประเมิน 
ข้ันสรุป (สัปดาห์ละ 30 นาท)ี 
1. ครูและนกัเรียนร่วมกนัสรุปสาระส าคญั 

2. นกัเรียนสอบถามขอ้สงสัย 

3. ฟังและจดบนัทึก 

4. ท าแบบฝึกหดัทา้ยบท 

5. ท าแบบทดสอบหลงัเรียน 

4.   กจิกรรมการเรียนรู้ 

 ก่อนเรียน 
1. คน้ควา้ค าเก่ียวกบัความสามารถโดยรวมของการจดัการไฟลง์านและเคร่ืองมือพื้นฐาน 

 ขณะเรียน 

1. ท าความเขา้ใจและปฎิบติัตามในแต่ละหวัขอ้การเรืยน 

2. ท าใบงานและแบบฝึกหดัหลงัเรียน 

3. ร่วมกนัเฉลยใบงานและแบบฝึกหดัหลงัเรียน 

4. จดบนัทึก เทคนิค แนวการท่ีเป็นประโยชน์ต่อผูเ้รียน จากขอ้แนะน าของครูผูส้อน 

5. ผูเ้รียนสรุปความรู้ท่ีไดจ้ากการเรียนตามความเป็นจริง จากภูมิความรู้ของผูเ้รียนแต่ละคน 

6. ผูเ้รียนซกัถามในหวัขอ้ท่ีสงสัยในเน้ือหาการเรียนรู้ 

5.  ส่ือการเรียนการสอน 

1. หนงัสือประกอบการเรียนวชิา การผลิตส่ือส่ิงพิมพ ์    

2. แฟ้มสะสมผลงาน   

3. ใบความรู้ประจ าหน่วย 

4. เคร่ืองไมโครคอมพิวเตอร์ 
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5. แผน่ใสและเคร่ืองฉายภาพขา้มศีรษะ 

6. ซีดีส่ือการสอนเร่ืองระบบฐานขอ้มูล 

 

6. วดัผลประเมินผล 

1. ผูเ้รียนปฏิบติัภาระงานท่ีมอบหมายเสร็จทนัเวลาท่ีก าหนด 

2. ตอบค าถามและสรุปผลงานไดอ้ยา่งถูกตอ้ง 

3. ท าแบบฝึกหดัหลงัเรียนเสร็จทนัเวลาท่ีก าหนดและถูกตอ้ง  

4. สนใจกระตือรือร้นในการเรียนรู้ ตอบค าถาม สรุปสาระการเรียนรู้ และกลา้แสดงความคิดเห็น 

7.   กจิกรรมเสนอแนะ 

ถา้ผูเ้รียนมีการเตรียมตวัในการเรียนท่ีดี เช่น อ่าน และท าการศึกษาหนงัสือเก่ียวกบัหน่วยการเรียนมาก
ก่อน ถึงชั่วโมงเรียน ผูเ้รียน จะสามารถเรียน และท ากิจกรรมต่าง ๆ ท่ีครูผูส้อนมอบหมาย ไดอ้ย่างมีความสุข 
และเกิดความชอบ และสนุกกบัการเรียนในชั้นเรียน 

 

เฉลยแบบฝึกหัดหน่วยที ่ 5 

ตอนท่ี 1 จงตอบค าถามต่อไปน้ี 

1. จงบอกขั้นตอนการสร้างไฟลง์าน โดยใช ้Template 

 1. คลิกท่ี Start->All Programs->Adobe InDesign เพ่ือเปิดโปรแกรม Adobe InDesign  

 2. คลิกท่ีเมน ูFile->New->Document from Template เพ่ือเปิดหน้าต่าง Templates ขึน้มา  

 3. ปรากฏหน้าต่าง Adobe Bridge คลิกเลิือกหมวดหมู่งานพิมพ์ในโฟลเดอร์ท่ีต้องการจากแทบ็ Content  

    ได้แก่ Book, Brochures, Business Sets, Catalog, Cd-Dvd, Certificate, Community, Newspaper และ 

    อ่ืนๆ   

 4. คลิกเลือกรูปแบบงานพิมพ์ท่ีต้องการ 

 5. ปรากฏไฟล์งานพิมพ์ท่ีเป็นใบงานน าเสนอ ดับเบิล้คลิกเพ่ือเปิดช้ินงานตัวอย่างท่ีต้องการขึน้มาใช้งาน  
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2. ค าสั่งท่ีใชใ้นการยอ่-ขยายมีอะไรบา้ง และมีความหมายอยา่งไร 

 Zoom In   ขยายมมุมองของหน้ากระดาษให้เพ่ิมขึน้ 1 ขัน้ เช่น จากเดิม 50% จะเพ่ิมขึน้  

    เป็น 75% 

 Zoom Out  ลดมมุมองของหน้ากระดาษลง 1 ขัน้ เช่น จากเดิม 50% จะลดลงเป็น 25% 

 Fit Page in Window แสดงมมุมองของหน้ากระดาษเดี่ยว (Page) ให้มขีนาดพอดีกับ  
    หน้าต่างโปรแกรม 

 Fit Spread in Window แสดงมมุมองของหน้ากระดาษคู่ (Spread) ให้มขีนาดพอดีกับ  
    หน้าต่างโปรแกรม 

 Actual Size  แสดงมมุมองของหน้ากระดาษท่ีระยะ 100% 

 Entire Pasteboard   แสดงองค์ประกอบท้ังหมดในงานพิมพ์ รวมท้ังพืน้ท่ีรอบข้างท้ังหมด 

 

 

3. การยกเลิกการกระท าท่ีไม่ตอ้งการมีก่ีแบบ อะไรบา้ง 

มี 2 แบบ คือ 

1. ยกเลิกการกระท าคร้ังล่าสุดด้วยค าส่ัง Undo 

โปรแกรมจดจ าการกระท าคร้ังล่าสุดเอาไว้ เราสามารถยกเลิกการกระท าคร้ังล่าสุดได้โดยใช้ค าส่ัง Undo 
แต่ค าส่ัง Undo จะเปลี่ยนไปตามการกระท าท่ีเราได้ท าลงไป เช่นหากเราลบอะไรไป กจ็ะปรากฏค าส่ัง Undo 
Clear แต่หากเราพิมพ์หรือแก้ไขข้อความใดๆ กจ็ะปรากฏเป็น Undo Typing 

2. ยกเลิกการกระท าหลังการบันทกึไฟล์ 

เม่ือเราแก้ไขงานพิมพ์ไปแล้วรู้สึกไม่ชอบ  เราสามารถยกเลิกการกระท าท้ังหมดท่ีเกิดขึน้หลังการบันทึก
ไฟล์งานพิมพ์นี ้โดยใช้ค าส่ัง Revert เพ่ือให้งานพิมพ์กลับไปเหมือนกับตอนท่ีได้บันทึกไว้คร้ังล่าสุด 

4. เส้นไกดมี์ทั้งหมดก่ีชนิด อะไรบา้ง 

ชนิดของเส้นไกด์มท้ัีงหมด 3 ชนิดได้แก่  
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1.  เส้นไกด์ท่ีเกิดจากระยะห่างจากขอบกระดาษ (Margin guide) 

2.  เส้นไกด์ท่ีเกิดจากการแบ่งคอลัมน์ (Column guide) 

3.  เส้นไกด์ท่ีสร้างขึน้จากแถบไม้บรรทัด (Ruler guide)  

5. เส้นไกดท่ี์เกิดจากการแบ่งคอลมัน์คืออะไร มีขั้นตอนในการสร้างอยา่งไร 

คือเส้นไกด์ท่ีใช้แบ่งหน้ากระดาษออกเป็นหลายคอลัมน์ เพ่ือช่วยในการแบ่งขอบเขตในการจัดวางเนือ้หา
ท้ังข้อความ และภาพใช้ควบคุมการไหลของข้อความท่ีเป็น Text blocks โดยมขีัน้ตอนในการสร้าง ดังนี ้

1. คลิกเลือกแทบ็ Pages Panel แล้วคลิกเลือกหน้ากระดาษท่ีต้องการแบ่งคอลัมน์ 

2. เลือกค าส่ัง Layout->Margins and Columns 

3. ปรากฏหน้าต่าง Margins and Columns จากนั้นให้เราก าหนดจ านวนของคอลัมน์ในช่อง Number และ 

    ระยะห่างของของคอลัมน์ในช่อง Gutter (จากตัวอย่างจะเป็นการก าหนดคอลัมน์ของงานพิมพ์หน้าคู่ ซ่ึง 

    ก าหนดจ านวนคอลัมน์ 3 คอลัมน์และก าหนดระยะห่างของคอลัมน์เท่ากับ 0.25 นิว้) 

 Number : จ านวนของคอลัมน์ท่ีเราต้องการ 

 Gutter : ระยะห่างท่ีเป็นช่องว่างระหว่างคอลัมน์ 4. คลิกเมาส์ท่ีปุ่ม OK เพ่ือตกลงใช้ค่าท่ีก าหนด 
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แผนจัดการเรียนรู้   หน่วยที ่6 

รายวชิา    การผลิตส่ือส่ิงพิมพ ์ สอนคร้ังที ่7-8 

ช่ือเร่ือง   การท างานกบัขอ้ความ จ านวน  4 ช่ัวโมง 

 

1.  สาระส าคัญ 

 เรียนรู้การท างานกบัขอ้ความในขั้นพื้นฐาน เป็นส่วนท่ีส าคอัยา่งมากในการสร้างงานพิมพ ์ โดยเร่ิม
เรียนรู้ตั้งแต่การสร้างขอ้ความ และการท างานกบัขอ้ความท่ีสร้างไว ้ 
 
2. ผลการเรียนรู้ทีค่าดหวงั 

1. อธิบายการสร้างขอ้ความประเภทต่างๆ ได ้

2. บอกเก่ียวกบัการปรับแต่งขอ้ความแบบ Type on Path ได ้

3. รู้จกัเก่ียวกบัขอ้ความใน Adobe InDesign 

4. สามารถคดัลอกขอ้ความจากไฟลโ์ปรแกรมอ่ืนๆ มาใชง้านได ้

5. อธิบายการไหลของขอ้ความได ้

6. อธิบายเก่ียวกบัการใชค้อลมัน์ได ้

7. สามารถตดัและรวมขอ้ความได ้
8. สามารถแกไ้ขขอ้ความในพื้นท่ี Story Editor ได ้
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3.  กจิกรรมการเรียนรู้ 

กจิกรรมครู 

ข้ันน าเข้าสู่บทเรียน (สัปดาห์ละ 30 นาท)ี 
1.  ใหค้วามร่วมมือกบัครูในการตรวจสอบ 
2. คน้ควา้เร่ือง ส่ือส่ิงพิมพ ์
3. ร่วมสนทนาและแสดงความคิดเห็น 
4. ท าแบบทดสอบก่อนเรียน 
ขั้นด าเนินการสอน (สัปดาห์ละ 180 นาท)ี 
21. ฟัง ท าความเขา้ใจและซกัถาม 
22. แบ่งกลุ่ม 
23. ฟัง ท าความเขา้ใจและปฎิบติัตาม 
24. ผูเ้รียนซกัถามขอ้สงสัยและจดบนัทึก 
25.  รับการประเมิน 
ข้ันสรุป (สัปดาห์ละ 30 นาท)ี 
21. ครูและนกัเรียนร่วมกนัสรุปสาระส าคญั 
22. นกัเรียนสอบถามขอ้สงสัย 
23. ฟังและจดบนัทึก 
24. ท าแบบฝึกหดัทา้ยบท 
25. ท าแบบทดสอบหลงัเรียน 

 

กจิกรรมนักเรียน 

ขั้นน าเข้าสู่บทเรียน (สัปดาห์ละ 30 นาท)ี 
1.  ใหค้วามร่วมมือกบัครูในการตรวจสอบ 

2. คน้ควา้เร่ือง การออกแบบส่ือส่ิงพิมพ ์

3. ร่วมสนทนาและแสดงความคิดเห็น 



44 
 

4.  ท าแบบทดสอบก่อนเรียน 

ขั้นด าเนินการสอน (สัปดาห์ละ 180 นาท)ี 
26. ฟัง ท าความเขา้ใจและซกัถาม 
27. แบ่งกลุ่ม 
28. ฟัง ท าความเขา้ใจและปฎิบติัตาม 
29. ผูเ้รียนซกัถามขอ้สงสัยและจดบนัทึก 
30.  รับการประเมิน 
ข้ันสรุป (สัปดาห์ละ 30 นาท)ี 
1. ครูและนกัเรียนร่วมกนัสรุปสาระส าคญั 

2. นกัเรียนสอบถามขอ้สงสัย 

3. ฟังและจดบนัทึก 

4. ท าแบบฝึกหดัทา้ยบท 

5. ท าแบบทดสอบหลงัเรียน 

4.   กจิกรรมการเรียนรู้ 

ก่อนเรียน 
1. คน้ควา้ค าเก่ียวกบัการท างานกบัขอ้ความ 
 ขณะเรียน 

1. ท าความเขา้ใจและปฎิบติัตามในแต่ละหวัขอ้การเรืยน 

2. ท าใบงานและแบบฝึกหดัหลงัเรียน 

3. ร่วมกนัเฉลยใบงานและแบบฝึกหดัหลงัเรียน 

4. จดบนัทึก เทคนิค แนวการท่ีเป็นประโยชน์ต่อผูเ้รียน จากขอ้แนะน าของครูผูส้อน 

5. ผูเ้รียนสรุปความรู้ท่ีไดจ้ากการเรียนตามความเป็นจริง จากภูมิความรู้ของผูเ้รียนแต่ละคน 

6. ผูเ้รียนซกัถามในหวัขอ้ท่ีสงสัยในเน้ือหาการเรียนรู้ 

5.  ส่ือการเรียนการสอน 

1. หนงัสือประกอบการเรียนวชิา การผลิตส่ือส่ิงพิมพ ์
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2. แฟ้มสะสมผลงาน   

3. ใบความรู้ประจ าหน่วย 

4. เคร่ืองไมโครคอมพิวเตอร์ 

5. แผน่ใสและเคร่ืองฉายภาพขา้มศีรษะ 

6. ซีดีส่ือการสอนเร่ืองระบบฐานขอ้มูล 

6. วดัผลประเมินผล 

1. ผูเ้รียนปฏิบติัภาระงานท่ีมอบหมายเสร็จทนัเวลาท่ีก าหนด 

2. ตอบค าถามและสรุปผลงานไดอ้ยา่งถูกตอ้ง 

3. ท าแบบฝึกหดัหลงัเรียนเสร็จทนัเวลาท่ีก าหนดและถูกตอ้ง  

4. สนใจกระตือรือร้นในการเรียนรู้ ตอบค าถาม สรุปสาระการเรียนรู้ และกลา้แสดงความคิดเห็น 

7.   กจิกรรมเสนอแนะ 

ถา้ผูเ้รียนมีการเตรียมตวัในการเรียนท่ีดี เช่น อ่าน และท าการศึกษาหนงัสือเก่ียวกบัหน่วยการเรียนมาก
ก่อน ถึงชั่วโมงเรียน ผูเ้รียน จะสามารถเรียน และท ากิจกรรมต่าง ๆ ท่ีครูผูส้อนมอบหมาย ไดอ้ย่างมีความสุข 
และเกิดความชอบ และสนุกกบัการเรียนในชั้นเรียน 

เฉลยแบบฝึกหัดหน่วยที ่ 6 

ตอนท่ี 2 จงท าเคร่ืองหมาย  ลอ้มรอบตวัเลือกท่ีถูกตอ้งท่ีสุด 

1. ขอ้ใดคือรูปแบบของขอ้ความในโปรแกรม InDesign 

ก. Text Form   ข. Text Block 

ค. Text Book   ง. Text Box 

2. ขอ้ใดไม่ใช่รูปแบบของ Frame Tool 

ก. Rectangle Tool  ข. Polygon Frame Tool 

ค. Ellipse Frame Tool  ง. Rectangle Frame Tool 

3. การใชเ้มาส์คลิกท่ีเส้นตั้งฉาก  บนเส้นพาธตรงกลางขอ้ความ และคลิกลากไปอีกดา้นของพาธ  



46 
 

หมายถึงการกระท าใด 

ก. ดึงขอ้ความ   ข. แกไ้ขขอ้ความ 

ค. วางขอ้ความ   ง. พลกิกลบัข้อความ 

4. การจดัวางตวัอกัษรใหต้ั้งตรง ไม่เอียงตามเส้นพาธ หมายถึงค าสั่งใดในหนา้ต่าง Type on a Path  

Options 

ก. Skew   ข. Gravity 

ค. 3D Ribbon   ง. Rainbow 

5. การจดัวางตวัอกัษรใหบิ้ดเอียงดูมีมิติ หมายถึงค าสั่งใดในหนา้ต่าง Type on a Path Options 

ก. Skew   ข. Gravity 

ค. 3D Ribbon   ง. Rainbow 

6. เป็นการจดัวางตวัอกัษรให้เอียง และตั้งฉากสัมพนัธ์กบัความโคง้ของเส้นพาธ หมายถึงค าสั่งใดใน
หนา้ต่าง Type on a Path Options 

ก. Skew   ข. Gravity 

ค. 3D Ribbon   ง. Rainbow 

7. การเลือกขอ้ความโดยใช ้ Selection Tool หมายถึงขอ้ใด 

ก. ขอ้ความในสถานะพื้นหลงั ข. ขอ้ความในสถานะรูปภาพ 

ค. ขอ้ความในสถานะตวัอกัษร ง. ข้อความในสถานะวตัถุ 

8. การเลือกขอ้ความโดยใช ้  Type Tool หมายถึงขอ้ใด 

ก. ขอ้ความในสถานะวตัถุ  ข. ข้อความในสถานะตัวอกัษร 

ค. ขอ้ความในสถานะรูปภาพ  ง. ขอ้ความในสถานะพื้นหลงั 

9.  ปุ่ม  ในค าสั่งก าหนดขอบเขตการคน้หา หมายถึงขอ้ใด 

ก. ค้นหาแบบแยกตัวพมิพ์ใหญ่เลก็ 

ข. คน้หาค าในส่วนเชิงอรรถ 
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ค. คน้หาค าในกรอบขอ้ความท่ีถูกล็อก 

ง. คน้หาค าโดด คน้หาเป็นค า 

10.  ปุ่ม   ในค าสั่งก าหนดขอบเขตการคน้หา หมายถึงขอ้ใด 

ก. คน้หาค าในเลเยอร์ท่ีถูกล็อก 

ข. ค้นหาค าในกรอบข้อความทีถู่กลอ็ก 

ค. คน้หาค าในเลเยอร์ท่ีถูกซ่อน 

ง. คน้หาค าในส่วนเชิงอรรถ 

ตอนที ่2 จงตอบค าถามต่อไปนี ้

 

1. รูปแบบของขอ้ความในโปรแกรม InDesign มีก่ีประเภท อะไรบา้งจงอธิบาย 

รูปแบบของข้อความในโปรแกรม InDesign ม ี2 ประเภท คือ 

1. Text block เป็นข้อความเกือบท้ังหมดท่ีอยู่ในงามพิมพ์ท่ีสร้างจากโปรแกรม InDesign ซ่ึงสร้างขึน้ 
โดยใช้  Type Tool ส าหรับพิมพ์ข้อความลงบนงานพิมพ์ และ  Type on a Path Tool ส าหรับพิมพ์ข้อความ
บนพาธ 

2. Text frame เป็นข้อความท่ีสร้างขึน้ภายในเฟรม ซ่ึงข้อความประเภทนีเ้ราต้องสร้างเฟรมขึน้มาก่อน 
โดยใช้ Frame Tool แล้วจึงใช้  Type Tool พิมพ์ข้อความลงในเฟรม 

 

2. รายละเอียดในการก าหนด Effect ในหนา้ต่าง Type on a Path Options มีอะไรบา้งจงอธิบาย 

Rainbow เป็นการจัดวางตัวอักษรให้เอียง และตั้งฉากสัมพันธ์กับความโค้งของเส้นพาธ 

Skew เป็นการจัดวางตัวอักษรให้ตั้งตรง ไม่เอียงไปตามความโค้งของเส้นพาธ 

 

3D Ribbon เป็นการจัดวางตัวอักษรให้บิดเอียงดูมมิีติ  โดยด้านล่างของตัวอักษรยึดตรงกับเส้นพาธ และ 

  ดึงด้านบนของตัวอักษรให้เอียงตามเส้นพาธ 
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Stair Step เป็นการจัดวางตัวอักษรให้ตั้งตรง และวางแต่ละตัวซ้อนกันเป็นขัน้ๆ ไปตามเส้นพาธ  

  (ควรก าหนดระยะห่างของตัวอักษรให้เหมาะสม เพราะอาจท าให้ตัวอักษรซ้อนทับกันจนอ่าน 

  ไม่รู้เร่ือง) 

Gravity เป็นการจัดวางตัวอักษร โดยใช้จุดศูนย์กลางในการดึงตัวอักษรแต่ละตัวให้เอียงเป็นจุดเดียวกัน 

Ascender เป็นการจัดต าแหน่งข้อความให้อยู่ใต้เส้นพาธ 

Descender เป็นการจัดต าแหน่งข้อความ ให้อยู่เหนือเส้นพาธ 

Center เป็นการจัดต าแหน่งข้อความ ให้อยู่คร่อมเส้นพาธ 

Baseline เป็นการจัดต าแหน่งข้อความ ให้อยู่บนเส้นพาธพอดี 

Top ก าหนดให้ข้อความอยู่ด้านบนจากต าแหน่งในช่อง Align 

Bottom ก าหนดให้ข้อความอยู่ด้านล่างจากต าแหน่งในช่อง Align 

Center ก าหนดให้ข้อความ อยู่ด้านตรงกลางจากต าแหน่งใน ช่อง Align.... 

 

3. ในหนา้ต่าง Find/Change ช่อง Search การก าหนดขอบเขตการคน้หาสามารถแบ่งเป็น 5 แบบ มี
อะไรบา้ง 

All Document ค้นหาในทุกเนือ้หาในทุกไฟล์ท่ีเปิดอยู่ในขณะนั้น 

Document  ค้นหาในทุกเนือ้หาในไฟล์ท่ีท าการค้นหาอยู่  

Story  ค้นหาเฉพาะในเนือ้หาท่ีท าการค้นหาอยู่  

To End of Story ค้นหาเฉพาะเนือ้หาท่ีเหลือ นับจากต าแหน่งเคอร์เซอร์ ไปจนถึงเนือ้หาบรรทัด
สุดท้าย 

Selection  ค้นหาเฉพาะข้อความท่ีไฮไลท์ไว้ 

4. จงบอกขั้นตอนในการก าหนดรูปแบบการคน้หา และแทนท่ีโดยใชห้นา้ต่าง Strory Editor พอเขา้ใจ 

1. คลิกท่ีเมนู Edit->Find/Change หรือกดคีย์<Ctrl>+F เพ่ือค้นหาและแทนท่ีค าท่ีก าหนด 

2. ปรากฏหน้าต่าง Find/Change ขึน้มา ให้พิมพ์ค าท่ีต้องการค้นหาลงในช่อง Find what 
และพิมพ์ค าใหม่ท่ีต้องการแทนท่ีลงในช่อง Change to 
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3. ในช่อง Search คลิกเลือกขอบเขตการแทนท่ี 

4. คลิกเมาส์ท่ี OK เพ่ือเร่ิมการค้นหาและแทนท่ีค า 
         5. เราสามารถน าขอ้ความจากวตัถุท่ีสองมารวมกบัวตัถุแรกไดด้ว้ยวธีิการอยา่งไร 

1. คลิกเลือก Selection Tool แล้วคลิกเลือกวตัถขุ้อความท่ีสองท่ีต้องการรวมกับข้อความอ่ืน 

2. คลิกท่ีเมนู Edit->Cut หรือกดคีย์ <Ctrl>+X เพ่ือตัดข้อความ 

3.คลิกเลือก Type Tool เลือกต าแหน่งท่ีต้องการจัดวางข้อความ 

4. คลิกท่ีเมนู Edit->Paste หรือกดคีย์ <Ctrl>+V 

5. ข้อความจากวตัถท่ีุสอง จะถกูรวมกับวตัถแุรก 

ตอนท่ี 3 แบบฝึกปฏิบติั 

จงพิมพข์อ้ความดงัตวัอยา่ง ใส่ลงในเฟรมรูุปส่ีเหล่ียม 2 รูป ลงใน 1 หนา้กระดาษ จากนั้นท าการบนัทึก 
โดยตั้งช่ือวา่ myfile2 
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แผนจัดการเรียนรู้   หน่วยที ่7 

รายวชิา    การผลิตส่ือส่ิงพิมพ ์ สอนคร้ังที ่9-10 

ช่ือเร่ือง   การปรับแต่งและจดัวางขอ้ความ จ านวน  4 ช่ัวโมง 

 
1.  สาระส าคัญ 

เรียนรู้การปรับแต่งขอ้ความท่ีเราไดส้ร้างข้ึน โดยการก าหนดรูปแบบ ไดแ้ก่ ฟอนต ์ ขนาด ลกัษณะ 
ระยะห่างตวัอกัษร บรรทดั และรูปแบบของแทบ็/ยอ่หนา้ นอกจากการปรับแต่งค่าแลว้ ยงัสามารถก าหนด
รูปแบบขอ้ความเก็บไวใ้ชง้านไดอี้กดว้ย 

  
2. ผลการเรียนรู้ทีค่าดหวงั 

1. สามารถปรับแต่งอกัษรจากพาเนล Charactor ได ้
2. อธิบายการปรับแต่งอกัษรจาก Control Panel ได ้
3. บอกวธีิการจดัเรียงขอ้ความได ้
4. อธิบายการข้ึนตน้ยอ่หนา้ดว้ตวัอกัษรขนาดให่่ได ้
5. รู้จกัเก่ียวกบัสไตลข์อ้ความ 
6. สามารถเปล่ียนสีขอ้ความได ้
7.  อธิบายการนบัค าในขอ้ความได ้
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3.  กจิกรรมการเรียนรู้ 

กจิกรรมครู 

ข้ันน าเข้าสู่บทเรียน (สัปดาห์ละ 30 นาท)ี 
1.  ใหค้วามร่วมมือกบัครูในการตรวจสอบ 
2. คน้ควา้เร่ือง ส่ือส่ิงพิมพ ์
3. ร่วมสนทนาและแสดงความคิดเห็น 
4. ท าแบบทดสอบก่อนเรียน 
ขั้นด าเนินการสอน (สัปดาห์ละ 180 นาท)ี 
1. ฟัง ท าความเขา้ใจและซกัถาม 
2. แบ่งกลุ่ม 
3. ฟัง ท าความเขา้ใจและปฎิบติัตาม 
4. ผูเ้รียนซกัถามขอ้สงสัยและจดบนัทึก 
5.  รับการประเมิน 
ข้ันสรุป (สัปดาห์ละ 30 นาท)ี 
1. ครูและนกัเรียนร่วมกนัสรุปสาระส าคญั 
2. นกัเรียนสอบถามขอ้สงสัย 
3. ฟังและจดบนัทึก 
4. ท าแบบฝึกหดัทา้ยบท 
5. ท าแบบทดสอบหลงัเรียน 

 

กจิกรรมนักเรียน 

ข้ันน าเข้าสู่บทเรียน (สัปดาห์ละ 30 นาท)ี 
1.  ใหค้วามร่วมมือกบัครูในการตรวจสอบ 

2. คน้ควา้เร่ือง การออกแบบส่ือส่ิงพิมพ ์

3. ร่วมสนทนาและแสดงความคิดเห็น 
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4.  ท าแบบทดสอบก่อนเรียน 

ขั้นด าเนินการสอน (สัปดาห์ละ 180 นาท)ี 
1. ฟัง ท าความเขา้ใจและซกัถาม 
2. แบ่งกลุ่ม 
3. ฟัง ท าความเขา้ใจและปฎิบติัตาม 
4. ผูเ้รียนซกัถามขอ้สงสัยและจดบนัทึก 
5.  รับการประเมิน 
ข้ันสรุป (สัปดาห์ละ 30 นาท)ี 
1. ครูและนกัเรียนร่วมกนัสรุปสาระส าคญั 

2. นกัเรียนสอบถามขอ้สงสัย 

3. ฟังและจดบนัทึก 

4. ท าแบบฝึกหดัทา้ยบท 

5. ท าแบบทดสอบหลงัเรียน 

4.   กจิกรรมการเรียนรู้ 

 ก่อนเรียน 
1. คน้ควา้ค าเก่ียวกบัการปรับแต่งและจดัวางขอ้ความ 
 ขณะเรียน 

1. ท าความเขา้ใจและปฎิบติัตามในแต่ละหวัขอ้การเรืยน 

2. ท าใบงานและแบบฝึกหดัหลงัเรียน 

3. ร่วมกนัเฉลยใบงานและแบบฝึกหดัหลงัเรียน 

4. จดบนัทึก เทคนิค แนวการท่ีเป็นประโยชน์ต่อผูเ้รียน จากขอ้แนะน าของครูผูส้อน 

5. ผูเ้รียนสรุปความรู้ท่ีไดจ้ากการเรียนตามความเป็นจริง จากภูมิความรู้ของผูเ้รียนแต่ละคน 

6. ผูเ้รียนซกัถามในหวัขอ้ท่ีสงสัยในเน้ือหาการเรียนรู้ 
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5.  ส่ือการเรียนการสอน 

1. หนงัสือประกอบการเรียนวชิา การผลิตส่ือส่ิงพิมพ ์

2. แฟ้มสะสมผลงาน   

3. ใบความรู้ประจ าหน่วย 

4. เคร่ืองไมโครคอมพิวเตอร์ 

5. แผน่ใสและเคร่ืองฉายภาพขา้มศีรษะ 

6. ซีดีส่ือการสอนเร่ืองระบบฐานขอ้มูล 

6. วดัผลประเมินผล 

1. ผูเ้รียนปฏิบติัภาระงานท่ีมอบหมายเสร็จทนัเวลาท่ีก าหนด 

2. ตอบค าถามและสรุปผลงานไดอ้ยา่งถูกตอ้ง 

3. ท าแบบฝึกหดัหลงัเรียนเสร็จทนัเวลาท่ีก าหนดและถูกตอ้ง  

4. สนใจกระตือรือร้นในการเรียนรู้ ตอบค าถาม สรุปสาระการเรียนรู้ และกลา้แสดงความคิดเห็น 

7.   กจิกรรมเสนอแนะ 

ถา้ผูเ้รียนมีการเตรียมตวัในการเรียนท่ีดี เช่น อ่าน และท าการศึกษาหนงัสือเก่ียวกบัหน่วยการเรียนมาก
ก่อน ถึงชั่วโมงเรียน ผูเ้รียน จะสามารถเรียน และท ากิจกรรมต่าง ๆ ท่ีครูผูส้อนมอบหมาย ไดอ้ย่างมีความสุข 
และเกิดความชอบ และสนุกกบัการเรียนในชั้นเรียน 

เฉลยแบบฝึกหัดหน่วยที ่ 7 

ตอนท่ี 1 จงตอบค าถามต่อไปน้ี 

1. จงบอกขั้นตอนในการเปล่ียนสีของขอ้ความวา่มีอะไรบา้ง 

 1. คลิกเลือก  Type Tool จากนั้นเลือกข้อความท่ีต้องการเปลี่ยนสี 

 2. คลิกเลือกท่ีเมน ูWindow>Color หรือกดคีย์ <F6> เพ่ือเปิดพาเนล Color 

 3. จากนั้นคลิกท่ี   และเลือกโหมดสีท่ีเหมาะสมกับงานพิมพ์ ในตัวอย่างเลือกโหมดสี CMYK  

 4. ท่ีพาเนล Color จะปรากฏแถบเล่ือนของแม่สีจากโหมดสีเราเลือก โดยคลิกเลืิอกโทนสีในช่อง  
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     Spectum คลิกค้างท่ีปุ่ม   และเล่ือนแถบ เพ่ือปรับผสมความเข้มข้นของแม่สี ให้ได้สีตามต้องการ  

    ซ่ึงจะแสดงผลสีท่ีช่อง Fill 

 5. อีกวิธีในการเลือกสี ให้ดับเบิล้คลิกท่ีช่อง Fill จะปรากฏหน้าต่าง Color Picker จากนั้นคลิกเลือกสีใน 

    กรอบ RGB Color Space View ให้คลิกค้างท่ี   และเล่ือนขึน้เล่ือนลง เพ่ือปรับโทนสี โดยดูผลลัพธ์ 

        ของสีท่ีเลือกได้ท่ีช่อง Color และ คลิกเมาส์ท่ี  เพ่ือยืนยนัการเลือกสีท่ีต้องการ 

 6. ข้อความท่ีเลือกไว้จะเปลี่ยนสีตามต้องการ 

2. การก าหนดลกัษณะตวัอกัษรมีขั้นตอนอะไรบา้ง จงอธิบาย 

 1. คลิกเลือก  Type Tool จากนั้นเลือกข้อความส าคัท่ีต้องการเปลี่ยนลักษณะของตัวอักษร 

 2. คลิกเลือกลักษณะของตัวอักษรในช่อง Type Style ท่ีต้องการ ซ่ึงม ี4 ลักษณะ ดังนี ้

  Regular ตัวปกติ (ข้อความ) 

  Italic ตัวเอียง (ข้อความ) 

  Bold ตัวหนา (ข้อความ) 

  Bold Italic ตัวหนาเอียง (ข้อความ) 

  ในตัวอย่างคลิกเลือก Bold Italic เพ่ือให้ข้อความเป็นตัวหนาเอียง 

 3. ข้อความท่ีเราคลิกเลือกนั้น จะเปลี่ยนลักษณะของตัวอักษรตามท่ีก าหนด 

3. จงบอกวธีิการในการนบัจ านวนตวัอกัษรในกรอบขอ้ความ 

1.1 คลิกเลือก  Type Tool  

1.2 คลิกเมาส์ท่ีกรอบข้อความ 

2.  คลิกท่ีเมนู Window->Info หรือกดคีย์ <F8> 

 

4. จงบอกรายละเอียดของพาเนล Charactor วา่มีอะไรบา้ง 
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4.1 คือ รูปแบบตัวอักษร (Font) 

4.2 คือ ขนาดตัวอักษร (Font Size) 
        4.3 คือ ปรับช่องไฟตัวอักษร (Kerning) 

4.4 คือ ปรับความสูงของตัวอักษร (Vertical Scale) 
4.5 คือ ปรับการยกตัวอักษร (Baseline Shift) 
4.6 คือ ภาษา (Language) 
4.7 คือ ลักษณะตัวอักษร (Type Style) 
4.8 คือ ระยะห่างของบรรทัด (Leading) 
4.9 คือ ปรับเพ่ิม/ลดระยะห่าง (Tracking) 
4.10  คือ ปรับความกว้างของตัวอักษร (Horizontal Scale) 
4.11 คือ ปรับองศาการเอียงตัวอักษร (Skew) 

5. จงบอกรายละเอียดของปุ่มท่ีใชใ้นการจดัเรียงขอ้ความในพาเนล Paragraph วา่มีอะไรบา้ง 
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  คือ จัดเรียงข้อความชิดซ้าย 

  คือ จัดเรียงข้อความตรงกลาง 

 คือ  จัดเรียงข้อความชิดขวา 

 คือ จัดเรียงข้อความเหยยีดเตม็บรรทัดสุดท้ายชิดซ้าย 

 คือ จัดเรียงข้อความเหยยีดเตม็บรรทัดสุดท้ายจัดกลาง 

 คือ จัดเรียงข้อความเหยยีดเตม็บรรทัดสุดท้ายชิดขวา 

 คือ จัดเรียงข้อความเหยยีดเตม็ทุกบรรทัด 

 คือ จัดเรียงข้อความชิดด้านฝ่ังหยกัน้อย 
 คือ จัดเรียงข้อความชิดด้านฝ่ังหยกัมาก 

ตอนท่ี 2 แบบฝีกปฏิบติัเปิดไฟลจ์ากแบบฝึกปฏิบติัท่ีผา่นมา (myfile2) แลว้ก าหนดช่ือเร่ืองเพียง 1 เร่ือง (วางช่ือ
เร่ืองไวท่ี้บรรทดับนสุดของขอ้ความ) โดยใชข้นาดตวัอกัษร 36 pt โดยจะใชรู้ปแบบและลกัษณะใดก็ได ้ใส่สี
ตกแต่งตามตอ้งการ จากนั้นก าหนดใหต้วัอกัษรตวัแรกของยอ่หนา้เป็นตวัอกัษรตวัให่่ แลว้บนัทึกเป็น myfile3 
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แผนจัดการเรียนรู้   หน่วยที ่8 

รายวชิา    การผลิตส่ือส่ิงพิมพ ์ สอนคร้ังที ่11-10 

ช่ือเร่ือง   การวาดวตัถุประกอบ  จ านวน  4 ช่ัวโมง 

 

1.  สาระส าคัญ 

 การจดัหนา้หนงัสือ หรือการออกแบบช้ินงานส่วนประกอบท่ีส าคอีักอยา่งหน่ึงนอกจากตวัอกัษรก็คือ
ภาพวตัถุท่ีจะน ามาใชป้ระกอบ ซ่ึงโปรแกรม InDesign ก็มีเคร่ืองมือส าหรับวาดภาพใหใ้ชง้านไดอ้ยา่ง
สะดวกสบาย ซ่ึงในบทน้ีจะกล่าวถึงการวาดภาพวตัถุดว้ยเคร่ืองมือสร้างภาพต่างๆ โดยจะอธิบายถึงหลกัการ
ของภาพวาดวา่ ภาพท่ีวาดออกมาจะมีลกัษณะอยา่งไร และมีการใชง้านเคร่ืองมืออยา่งไร 

 

  
2. ผลการเรียนรู้ทีค่าดหวงั 

1. รู้จกัเก่ียวกบัเส้นพาธ 
2. สามารถการวาดเส้นตรงได ้
3. สามารถวาดรูปทรงแบบตายตวัได ้
4.  สามารถวาดรูปทรงอยา่งอิสระได ้
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3.  กจิกรรมการเรียนรู้ 

กจิกรรมครู 

ขั้นน าเข้าสู่บทเรียน (สัปดาห์ละ 30 นาท)ี 
1.  ใหค้วามร่วมมือกบัครูในการตรวจสอบ 
2. คน้ควา้เร่ือง ส่ือส่ิงพิมพ ์
3. ร่วมสนทนาและแสดงความคิดเห็น 
4. ท าแบบทดสอบก่อนเรียน 
ขั้นด าเนินการสอน (สัปดาห์ละ 180 นาท)ี 
26. ฟัง ท าความเขา้ใจและซกัถาม 
27. แบ่งกลุ่ม 
28. ฟัง ท าความเขา้ใจและปฎิบติัตาม 
29. ผูเ้รียนซกัถามขอ้สงสัยและจดบนัทึก 
30.  รับการประเมิน 
ข้ันสรุป (สัปดาห์ละ 30 นาท)ี 
26. ครูและนกัเรียนร่วมกนัสรุปสาระส าคญั 
27. นกัเรียนสอบถามขอ้สงสัย 
28. ฟังและจดบนัทึก 
29. ท าแบบฝึกหดัทา้ยบท 
30. ท าแบบทดสอบหลงัเรียน 

 
กจิกรรมนักเรียน 

 

ข้ันน าเข้าสู่บทเรียน (สัปดาห์ละ 30 นาท)ี 
1.  ใหค้วามร่วมมือกบัครูในการตรวจสอบ 

2. คน้ควา้เร่ือง การออกแบบส่ือส่ิงพิมพ ์

3. ร่วมสนทนาและแสดงความคิดเห็น 
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4.  ท าแบบทดสอบก่อนเรียน 

ขั้นด าเนินการสอน (สัปดาห์ละ 180 นาท)ี 
1. ฟัง ท าความเขา้ใจและซกัถาม 
2. แบ่งกลุ่ม 
3. ฟัง ท าความเขา้ใจและปฎิบติัตาม 
4. ผูเ้รียนซกัถามขอ้สงสัยและจดบนัทึก 
5.  รับการประเมิน 
ข้ันสรุป (สัปดาห์ละ 30 นาท)ี 
1. ครูและนกัเรียนร่วมกนัสรุปสาระส าคญั 

2. นกัเรียนสอบถามขอ้สงสัย 

3. ฟังและจดบนัทึก 

4. ท าแบบฝึกหดัทา้ยบท 

5. ท าแบบทดสอบหลงัเรียน 

4.   กจิกรรมการเรียนรู้ 

 ก่อนเรียน 
 1. คน้ควา้ค าเก่ียวกบัการวาดวตัถุประกอบ 

 ขณะเรียน 

1. ท าความเขา้ใจและปฎิบติัตามในแต่ละหวัขอ้การเรืยน 

2. ท าใบงานและแบบฝึกหดัหลงัเรียน 

3. ร่วมกนัเฉลยใบงานและแบบฝึกหดัหลงัเรียน 

4. จดบนัทึก เทคนิค แนวการท่ีเป็นประโยชน์ต่อผูเ้รียน จากขอ้แนะน าของครูผูส้อน 

5. ผูเ้รียนสรุปความรู้ท่ีไดจ้ากการเรียนตามความเป็นจริง จากภูมิความรู้ของผูเ้รียนแต่ละคน 

6. ผูเ้รียนซกัถามในหวัขอ้ท่ีสงสัยในเน้ือหาการเรียนรู้ 

5.  ส่ือการเรียนการสอน 

1. หนงัสือประกอบการเรียนวชิา การผลิตส่ือส่ิงพิมพ ์
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2. แฟ้มสะสมผลงาน   

3. ใบความรู้ประจ าหน่วย 

 4. เคร่ืองไมโครคอมพิวเตอร์ 

5. แผน่ใสและเคร่ืองฉายภาพขา้มศีรษะ 

6. ซีดีส่ือการสอนเร่ืองระบบฐานขอ้มูล 

6. วดัผลประเมินผล 

1. ผูเ้รียนปฏิบติัภาระงานท่ีมอบหมายเสร็จทนัเวลาท่ีก าหนด 

2. ตอบค าถามและสรุปผลงานไดอ้ยา่งถูกตอ้ง 

3. ท าแบบฝึกหดัหลงัเรียนเสร็จทนัเวลาท่ีก าหนดและถูกตอ้ง  

4. สนใจกระตือรือร้นในการเรียนรู้ ตอบค าถาม สรุปสาระการเรียนรู้ และกลา้แสดงความคิดเห็น 

7.   กจิกรรมเสนอแนะ 

ถา้ผูเ้รียนมีการเตรียมตวัในการเรียนท่ีดี เช่น อ่าน และท าการศึกษาหนงัสือเก่ียวกบัหน่วยการเรียนมาก
ก่อน ถึงชั่วโมงเรียน ผูเ้รียน จะสามารถเรียน และท ากิจกรรมต่าง ๆ ท่ีครูผูส้อนมอบหมาย ไดอ้ย่างมีความสุข 
และเกิดความชอบ และสนุกกบัการเรียนในชั้นเรียน 

 

เฉลยแบบฝึกหัดหน่วยที ่ 8 

ตอนท่ี 1 จงท าเคร่ืองหมาย  ลอ้มรอบตวัเลือกท่ีถูกตอ้งท่ีสุด 

จงใชค้  าตอบต่อไปน้ี ตอบค าถามขอ้ 1 - 4 

ก. จุดยดึส่วนโคง้ 

ข. เส้นพาธแบบปิด 

ค. เส้นพาธแบบเปิด 

ง. จุดยดึส่วนมุม 

1. เส้นท่ีมีจุดยดึ จุดเร่ิมตน้ และจุดจบของพาธ ไม่เป็นจุดเดียวกนั หมายถึงขอ้ใด ตอบ ค. 
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2. จุดท่ีเช่ือมต่อเส้นตรงเขา้กบัเส้นตรง ซ่ึงจะอยูใ่นลกัษณะของมุม หมายถึงขอ้ใด ตอบ ง. 

3. จุดยดึท่ีเช่ือมต่อระหวา่งเส้นโคง้กบัเส้นโคง้ ซ่ึงจะมีลกัษณะเป็นส่วนโคง้ท่ีมีความต่อเน่ืองกนั  

   หมายถึงขอ้ใด ตอบ ก. 

4. เส้นท่ีมีจุดยดึ จุดเร่ิมตน้ของพาธ และจุดจบของพาธเป็นจุดเดียวกนั หมายถึงขอ้ใด ตอบ ข. 

5. ขอ้ใดต่อไปน้ีไม่เก่ียวขอ้งกบัการวาดรูปทรงแบบตายตวั 

ก. Rectangle Tool  

ข. Ellipse Tool  

ค. Polygon Tool  

ง. Pen Tool  

6. เคร่ืองมือ  Delete Anchor Point Tool หมายถึงขอ้ใด  

ก. ใชเ้ปล่ียนแขนของเส้นพาธใหเ้ป็นเส้นโคง้หรือเส้นตรง 

ข. ใชเ้พิ่มจุดในแนวเส้นพาธ 

ค. ใช้ลบจุดในแนวเส้นพาธ 
ง. ใชว้าดเส้นดว้ยปากกา 

7. เคร่ืองมือ  Convert Direction Point Tool หมายถึงขอ้ใด  

ก. ใช้เปลีย่นแขนของเส้นพาธให้เป็นเส้นโค้งหรือเส้นตรง 

ข. ใชเ้พิ่มจุดในแนวเส้นพาธ 

ค. ใชล้บจุดในแนวเส้นพาธ 

ง. ใชว้าดเส้นดว้ยปากกา 

8. เคร่ืองมือ  Add Anchor Point Tool หมายถึงขอ้ใด  

ก. ใชว้าดเส้นดว้ยปากกา 

ข. ใช้เพิม่จุดในแนวเส้นพาธ 

ค. ใชล้บจุดในแนวเส้นพาธ 
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ง. ใชเ้ปล่ียนแขนของเส้นพาธใหเ้ป็นเส้นโคง้หรือเส้นตรง 

9. เคร่ืองมือใดในขอ้ต่อไปน้ี ใชเ้พื่อการลบเส้นท่ีไม่ตอ้งการ 

ก. Smooth Tool  

ข. Erase Tool  

ค. Rectangle Tool  

ง. Pen Tool  

10. เคร่ืองมือใดในขอ้ต่อไปน้ี ใชเ้พื่อการตกแต่งเส้นโคง้ใหเ้รียบ 

ก. Smooth Tool  

ข. Erase Tool  

ค. Rectangle Tool  

ง. Pen Tool  

ตอนท่ี 3 แบบฝึกปฏิบติั 

จงวาดภาพดอกไมอ้ยูใ่นแจกนั โดยใชเ้ส้นสีด าในการวาด และไม่ตอ้งลงสี จากนั้นท าการบนัทึกลงในช่ือ 
myfile4 
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แผนจัดการเรียนรู้   หน่วยที ่9 

รายวชิา    การผลิตส่ือส่ิงพิมพ ์ สอนคร้ังที ่13-14 

ช่ือเร่ือง   การใชง้านวตัถุ จ านวน  4 ช่ัวโมง 

 

1.  สาระส าคัญ 

การใชง้านวตัถุ ไดแ้ก่ การเลือกวตัถุ การเคล่ือนยา้ย การปรับขนาด การคดัลอก การหมุน การกลบัภาพ การ
บิด การคร็อป และการล็อค เป็นตน้ การใชง้านวตัถุพื้นฐานเป็นเร่ืองท่ีจ าเป็นอยา่งมาก ในการจดัวางช้ินงานบน
หนา้กระดาษ เพราะองคป์ระกอบท่ีแสดงอยูบ่นหนา้กระดาษนั้นเป็นวตัถุทั้งหมด 

 
2. ผลการเรียนรู้ทีค่าดหวงั 

1. อธิบายการเลือกและเคล่ือนยา้ยวตัถุได ้
2. สามารถปรับขนาดวตัถุได ้
3. สามรถคดัลอก และวางวตัถุโดยใช ้Paste in Place ได ้
4. บอกวธีิการหมุนวตัถุโดยใช ้Rotating Tool ได ้
5. สามารถบิด และการพลิกกลบัดา้นวตัถุได ้
6. อธิบายการล็อควตัถุได ้
7. อธิบายการคร็อปรูปภาพได ้
8. สามารถลบวตัถุได ้
9. อธิบายการมาสกว์ตัถุได ้
10. อธิบายการรวมกลุ่ม และจดัล าดบัการซอ้นวตัถุได ้
11.สามารถจดัเรียงวตัถุได ้
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3.  กจิกรรมการเรียนรู้ 

กจิกรรมครู 

ข้ันน าเข้าสู่บทเรียน (สัปดาห์ละ 30 นาท)ี 
1.  ใหค้วามร่วมมือกบัครูในการตรวจสอบ 
2. คน้ควา้เร่ือง ส่ือส่ิงพิมพ ์
3. ร่วมสนทนาและแสดงความคิดเห็น 
4. ท าแบบทดสอบก่อนเรียน 
ขั้นด าเนินการสอน (สัปดาห์ละ 180 นาท)ี 
1. ฟัง ท าความเขา้ใจและซกัถาม 
2. แบ่งกลุ่ม 
3. ฟัง ท าความเขา้ใจและปฎิบติัตาม 
4. ผูเ้รียนซกัถามขอ้สงสัยและจดบนัทึก 
5.  รับการประเมิน 
ข้ันสรุป (สัปดาห์ละ 30 นาท)ี 
1. ครูและนกัเรียนร่วมกนัสรุปสาระส าคญั 
2. นกัเรียนสอบถามขอ้สงสัย 
3. ฟังและจดบนัทึก 
4. ท าแบบฝึกหดัทา้ยบท 
5. ท าแบบทดสอบหลงัเรียน 

 

กจิกรรมนักเรียน 

ข้ันน าเข้าสู่บทเรียน (สัปดาห์ละ 30 นาท)ี 
1.  ใหค้วามร่วมมือกบัครูในการตรวจสอบ 

2. คน้ควา้เร่ือง การออกแบบส่ือส่ิงพิมพ ์

3. ร่วมสนทนาและแสดงความคิดเห็น 

4.  ท าแบบทดสอบก่อนเรียน 
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ขั้นด าเนินการสอน (สัปดาห์ละ 180 นาท)ี 
1. ฟัง ท าความเขา้ใจและซกัถาม 
2. แบ่งกลุ่ม 
3. ฟัง ท าความเขา้ใจและปฎิบติัตาม 
4. ผูเ้รียนซกัถามขอ้สงสัยและจดบนัทึก 
5.  รับการประเมิน 
ข้ันสรุป (สัปดาห์ละ 30 นาท)ี 
1. ครูและนกัเรียนร่วมกนัสรุปสาระส าคญั 

2. นกัเรียนสอบถามขอ้สงสัย 

3. ฟังและจดบนัทึก 

4. ท าแบบฝึกหดัทา้ยบท 

5. ท าแบบทดสอบหลงัเรียน 

4.   กจิกรรมการเรียนรู้ 

 ก่อนเรียน 
1. คน้ควา้ค าเก่ียวกบัการใชง้านวตัถุ 
 ขณะเรียน 

1. ท าความเขา้ใจและปฎิบติัตามในแต่ละหวัขอ้การเรืยน 

2. ท าใบงานและแบบฝึกหดัหลงัเรียน 

3. ร่วมกนัเฉลยใบงานและแบบฝึกหดัหลงัเรียน 

4. จดบนัทึก เทคนิค แนวการท่ีเป็นประโยชน์ต่อผูเ้รียน จากขอ้แนะน าของครูผูส้อน 

5. ผูเ้รียนสรุปความรู้ท่ีไดจ้ากการเรียนตามความเป็นจริง จากภูมิความรู้ของผูเ้รียนแต่ละคน 

6. ผูเ้รียนซกัถามในหวัขอ้ท่ีสงสัยในเน้ือหาการเรียนรู้ 

5.  ส่ือการเรียนการสอน 

1. หนงัสือประกอบการเรียนวชิา การผลิตส่ือส่ิงพิมพ ์

2. แฟ้มสะสมผลงาน   
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3. ใบความรู้ประจ าหน่วย 

4. เคร่ืองไมโครคอมพิวเตอร์ 

5. แผน่ใสและเคร่ืองฉายภาพขา้มศีรษะ 

6. ซีดีส่ือการสอนเร่ืองระบบฐานขอ้มูล 

6. วดัผลประเมินผล 

1. ผูเ้รียนปฏิบติัภาระงานท่ีมอบหมายเสร็จทนัเวลาท่ีก าหนด 

2. ตอบค าถามและสรุปผลงานไดอ้ยา่งถูกตอ้ง 

3. ท าแบบฝึกหดัหลงัเรียนเสร็จทนัเวลาท่ีก าหนดและถูกตอ้ง  

4. สนใจกระตือรือร้นในการเรียนรู้ ตอบค าถาม สรุปสาระการเรียนรู้ และกลา้แสดงความคิดเห็น 

7.   กจิกรรมเสนอแนะ 

ถา้ผูเ้รียนมีการเตรียมตวัในการเรียนท่ีดี เช่น อ่าน และท าการศึกษาหนงัสือเก่ียวกบัหน่วยการเรียนมาก
ก่อน ถึงชั่วโมงเรียน ผูเ้รียน จะสามารถเรียน และท ากิจกรรมต่าง ๆ ท่ีครูผูส้อนมอบหมาย ไดอ้ย่างมีความสุข 
และเกิดความชอบ และสนุกกบัการเรียนในชั้นเรียน 

เฉลยแบบฝึกหัดหน่วยที ่ 9 

ตอนท่ี 1 จงตอบค าถามต่อไปน้ี 

1. การคดัลอกวตัถุมี 3 วธีิ จงอธิบายขั้นตอนของแต่ละวธีิมาอยา่งละเอียด 

วิธีท่ี 1 1. ใช้  Selection Tool คลิกเลือกวตัถท่ีุต้องการคัดลอก 
  2. เลือกค าส่ัง Edit>Copy หรือกดปุ่ม <Ctrl>+C ท่ีคีย์บอร์ด เพ่ือคัดลอกวตัถุ 
  3. เลือกค าส่ัง Edit>Paste หรือกดปุ่ม <Ctrl>+V ท่ีคีย์บอร์ด เพ่ือวางวตัถท่ีุคัดลอกมา 

  4.จะปรากฏวตัถใุหม่ท่ีได้จากการคัดลอก 

วิธีท่ี 2 1. คลิกเมาส์เลือกวตัถุ 

  2. คลิกเมาส์ขวาเลือก Copy เพ่ือคัดลอกวตัถ ุ

  3. คลิกเมาส์ขวาเลือก Paste เพ่ือวางวตัถุ 
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วิธีท่ี 3 1. คลิกเมาส์เลือกวตัถพุร้อมกับกดปุ่ม <Alt> ค้างไว้ 

  2. ลากเมาส์เล่ือนวตัถไุปวางยงัต าแหน่งใหม่ 

  3. ปล่อยเมาส์ วตัถุจะถกูตัดลอกเพ่ิมขึน้ 

2. รูปแบบในการซ้อนวตัถุมีอะไรบา้ง 

 Bring to Front  เล่ือนวัตถขึุน้มาให้อยู่บนสุด 

 Bring Forward  เล่ือนวัตถขึุน้มา 1 ช้ัน 

 Send Backward  เล่ือนวัตถลุงไป 1 ช้ัน 

 Send to Back  เล่ือนวัตถไุปอยู่หลังสุดของวัตถท้ัุงหมด 

3. จงอธิบายวธีิการหมุนโดยใช ้Rotate Tool 
 1. ใช้  Selection Tool คลิกเลือกวตัถท่ีุต้องการหมุน 
 2. คลิกเลือก  Rotate Tool จากกล่องเคร่ืองมือ เพ่ือหมนุวตัถุ 
 3. คลิกเมาส์วางจุดหมนุ   บริเวณท่ีต้องการ เพ่ือก าหนดให้เป็นจุดหมุนของวัตถุ 
 4. ลากเมาส์เพ่ือหมนุวัตถใุห้อยู่ในต าแหน่งท่ีเราต้องการ 

 5. ปล่อยเมาส์ วตัถุจะถกูหมุนตามท่ีเราต้องการทันที 

4. ในการก าหนดรูปแบบการจดัเรียงตามแนว ในพาเนล Align มีอะไรบา้งจงอธิบาย 
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5. จงอธิบายวธีิการในการมาสกว์ตัถุวา่ท าอยา่งไรบา้ง 
 1. เตรียมภาพท่ีต้องการมาสก์ ในตัวอย่างเป็นรูปผเีส้ือ 
 2. วาดวตัถท่ีุต้องการใช้เป็นตัวมาสก์ไว้บนรูปภาพ จากตัวอย่างวาดรูปวงกลมจากเคร่ืองมือ Ellipse  
     Frame Tool 
 3. คลิกเลือกวตัถุรูปภาพมดแล้วคลิกท่ี Edit>Copy 
 4. คลิกเลือกวตัถวุงกลมแล้วเลือกค าส่ัง Edit>Paste Into เพ่ือมาสก์รูปภาพ  
 5. รูปภาพจะถกูมาสก์ให้แสดงในรูปทรงตามท่ีต้องการทันที โดยรูปภาพท่ีท าการมาสก์จะยงัซ้อนอยู่บน 
    รูปภาพต้นแบบ 
 6. คลิกแล้วลากวตัถวุงกลมออกมายังพืน้ท่ีภายนอก 
 7. จะเห็นว่ารูปมดถกูมาสก์ด้วยรูปวงกลม 

ตอนท่ี 2 แบบฝึกหด้ภาคปฏิบติั 

เปิดไฟลจ์ากแบบฝึกหดัท่ีผา่นมา จากนั้นท าการคดัลอกภาพเป็น 4 ภาพพร้อมทั้งตั้งช่ือภาพวางท่ีดา้นล่าง
ของหนา้กระดาษ แลว้บนัทึกเป็น myfile5 
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แผนจัดการเรียนรู้   หน่วยที ่10 

รายวชิา    การผลิตส่ือส่ิงพิมพ ์ สอนคร้ังที ่15-16 

ช่ือเร่ือง   ความรู้เร่ืองสีและการใชง้านสี จ านวน  4 ช่ัวโมง 

 

1.  สาระส าคัญ 

 สีบนจอภาพ หรือส่ิงพิมพท่ี์เราเห็นนั้นเกิดจากการผสมสีท่ีลอกเลียนแบบธรรมชาติ ซ่ึงโปรแกรม
กราฟิกอยา่ง InDesign ไดน้ าหลกัการแสดงสีของโมเดลสีเขา้มาประยกุตใ์หเ้กิดเป็นโหมดส าหรับใชง้านได้
หลากหลาย ความรู้เร่ืองสีจึงมีความส าคอัยา่งยิง่ส าหรับคนท่ีตอ้งการออกแบบภาพกราฟิก ซ่ึงในบทน้ีน า
ความรู้ต่างๆ เก่ียวกบัสี และการระบายสีภาพดว้ยวธีิต่างๆ มากล่าวถึงอยา่งละเอียด เพื่อใหไ้ดภ้าพท่ีออกมา
สวยงามไดต้ามท่ีเราตอ้งการ 

  
2. ผลการเรียนรู้ทีค่าดหวงั 

1. รู้จกัโมเดลการมองเห็นสีทัว่ไป 
2. บอกโหมดสีท่ีใชง้านโปรแกรม InDesign ได ้
3. อธิบายการใส่สีใหว้ตัถุได ้
4. อธิบายการเลือกสีจาก Color Picker, พาเนล Color และพาเนล Swatches ได ้
5. สามารถท าการระบายสีดว้ยเคร่ืองมือ Eyedropper Tool ได ้
6. สามารถการระบายสีแบบไล่โทนได ้

 

 

 

 

 



72 
 
 

3.  กจิกรรมการเรียนรู้ 

กจิกรรมครู 

ข้ันน าเข้าสู่บทเรียน (สัปดาห์ละ 30 นาท)ี 
1.  ใหค้วามร่วมมือกบัครูในการตรวจสอบ 
2. คน้ควา้เร่ือง ส่ือส่ิงพิมพ ์
3. ร่วมสนทนาและแสดงความคิดเห็น 
4. ท าแบบทดสอบก่อนเรียน 
ขั้นด าเนินการสอน (สัปดาห์ละ 180 นาท)ี 
31. ฟัง ท าความเขา้ใจและซกัถาม 
32. แบ่งกลุ่ม 
33. ฟัง ท าความเขา้ใจและปฎิบติัตาม 
34. ผูเ้รียนซกัถามขอ้สงสัยและจดบนัทึก 
35.  รับการประเมิน 
ข้ันสรุป (สัปดาห์ละ 30 นาท)ี 
31. ครูและนกัเรียนร่วมกนัสรุปสาระส าคญั 
32. นกัเรียนสอบถามขอ้สงสัย 
33. ฟังและจดบนัทึก 
34. ท าแบบฝึกหดัทา้ยบท 
35. ท าแบบทดสอบหลงัเรียน 
 

กจิกรรมนักเรียน 

ข้ันน าเข้าสู่บทเรียน (สัปดาห์ละ 30 นาท)ี 
1.  ใหค้วามร่วมมือกบัครูในการตรวจสอบ 

2. คน้ควา้เร่ือง การออกแบบส่ือส่ิงพิมพ ์

3. ร่วมสนทนาและแสดงความคิดเห็น 
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4.  ท าแบบทดสอบก่อนเรียน 

ขั้นด าเนินการสอน (สัปดาห์ละ 180 นาท)ี 
1. ฟัง ท าความเขา้ใจและซกัถาม 
2. แบ่งกลุ่ม 
3. ฟัง ท าความเขา้ใจและปฎิบติัตาม 
4. ผูเ้รียนซกัถามขอ้สงสัยและจดบนัทึก 
5.  รับการประเมิน 
ข้ันสรุป (สัปดาห์ละ 30 นาท)ี 
1. ครูและนกัเรียนร่วมกนัสรุปสาระส าคญั 

2. นกัเรียนสอบถามขอ้สงสัย 

3. ฟังและจดบนัทึก 

4. ท าแบบฝึกหดัทา้ยบท 

5. ท าแบบทดสอบหลงัเรียน 

4.   กจิกรรมการเรียนรู้ 

 ก่อนเรียน 
2. คน้ควา้ค าเก่ียวกบัความรู้เร่ืองสีและการใชง้านสี 
 ขณะเรียน 

1. ท าความเขา้ใจและปฎิบติัตามในแต่ละหวัขอ้การเรืยน 

2. ท าใบงานและแบบฝึกหดัหลงัเรียน 

3. ร่วมกนัเฉลยใบงานและแบบฝึกหดัหลงัเรียน 

4. จดบนัทึก เทคนิค แนวการท่ีเป็นประโยชน์ต่อผูเ้รียน จากขอ้แนะน าของครูผูส้อน 

5. ผูเ้รียนสรุปความรู้ท่ีไดจ้ากการเรียนตามความเป็นจริง จากภูมิความรู้ของผูเ้รียนแต่ละคน 

6. ผูเ้รียนซกัถามในหวัขอ้ท่ีสงสัยในเน้ือหาการเรียนรู้ 

5.  ส่ือการเรียนการสอน 

1. หนงัสือประกอบการเรียนวชิา การผลิตส่ือส่ิงพิมพ ์
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2. แฟ้มสะสมผลงาน   

3. ใบความรู้ประจ าหน่วย 

4. เคร่ืองไมโครคอมพิวเตอร์ 

5. แผน่ใสและเคร่ืองฉายภาพขา้มศีรษะ 

6. ซีดีส่ือการสอนเร่ืองระบบฐานขอ้มูล 

6. วดัผลประเมินผล 

1. ผูเ้รียนปฏิบติัภาระงานท่ีมอบหมายเสร็จทนัเวลาท่ีก าหนด 

2. ตอบค าถามและสรุปผลงานไดอ้ยา่งถูกตอ้ง 

3. ท าแบบฝึกหดัหลงัเรียนเสร็จทนัเวลาท่ีก าหนดและถูกตอ้ง  

4. สนใจกระตือรือร้นในการเรียนรู้ ตอบค าถาม สรุปสาระการเรียนรู้ และกลา้แสดงความคิดเห็น 

7.   กจิกรรมเสนอแนะ 

ถา้ผูเ้รียนมีการเตรียมตวัในการเรียนท่ีดี เช่น อ่าน และท าการศึกษาหนงัสือเก่ียวกบัหน่วยการเรียนมาก
ก่อน ถึงชั่วโมงเรียน ผูเ้รียน จะสามารถเรียน และท ากิจกรรมต่าง ๆ ท่ีครูผูส้อนมอบหมาย ไดอ้ย่างมีความสุข 
และเกิดความชอบ และสนุกกบัการเรียนในชั้นเรียน 

 

เฉลยแบบฝึกหัดหน่วยที ่ 10 

ตอนท่ี 1 จงตอบค าถามต่อไปน้ี 

1. จงอธิบายขั้นตอนในการเลือกสีจากพาเนล Swatches 

ในการเลือกสีจากพาเนล Swatches ให้ใช้ค าส่ัง Window->Color ให้มีเคร่ืองหมายถกู หน้าค าส่ังนี ้ ซ่ึงจะ
ปรากฏพาเนล Color ขึน้มา จากนั้นท าตามขัน้ตอนดังนี ้

1. คลิกเลือกวตัถุ 

2. คลิกเลือกก าหนดสีพืน้ หรือสีเส้น 

3. คลิกเลือกสีท่ีต้องการ 
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2. จงบอกขั้นตอนในการระบายสีดว้ย Eyedropper Tool 

1. คลิกเลือกวตัถุ 

2. คลิกเลือก Eyedropper Tool 

3. เลือกสีจากต้นแบบ 

 

3. จงอธิบายขั้นตอนในการเลือกสีจาก Color Picker  

1. คลิกเลือกวตัถุ 

2. ดับเบิล้คลิกเมาส์ท่ีสีพืน้หรือสีเส้น 

3. เล่ือนสไลด์เลือกโทนสี 

4. ก าหนดค่าสีโดยการคลิกเมาส์ 

5. คลิกเมาส์ท่ี OK เพ่ือตกลงใช้สีท่ีเลือก 

 

4. จงบอกส่วนประกอบท่ีอยูใ่นพาเนล Gradient 

 

 4.1 คือ ก าหนดลักษณะการไล่สี   4.2 คือ ตัวอย่างการไล่สี 

 4.3 คือ แสดงต าแหน่งจุดสีท่ีเราท าการปรับอยู่  4.4 คือ สลับทิศทางการไล่เฉดสี 
 4.5 คือ จุดสีแต่ละจุด    4.6 คือ ก าหนดค่ามมุเอียงของการไล่สีแบบ Linear 
 4.7 คือ จุดระหว่างสีสองสี เพ่ือก าหนดขอบเขตการไล่โทนของสี 
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5. จงบอกความหมายของเคร่ืองมือเหล่าน้ี 

 

 5.1 คือ สีพืน้ (Fill)    5.2 คือ สีพืน้ฐานของโปรแกรม 
 5.3 คือ ก าหนดรูปแบบการใส่สี   5.4 คือ สลับสีพืน้ และสีเส้น 
 5.5 คือ สีเส้น (Stroke)    5.6 คือ ก าหนดให้ใส่สีวตัถุ หรือตัวอักษร 

ตอนท่ี 2 แบบฝึกปฏิบติั 

เปิดไฟลจ์ากแบบฝึกท่ีผา่นมา (myfile5) จากนั้นท าการใส่สีท่ีภาพ โดยก าหนดใหใ้นภาพมีท่ีการลงสีแบบ
ธรรมดาและการลงสีแบบ gradient แลว้บนัทึกเป็น myfile6 
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แผนจัดการเรียนรู้   หน่วยที ่11 

รายวชิา    การผลิตส่ือส่ิงพิมพ ์ สอนคร้ังที ่17-18 

ช่ือเร่ือง   เทคนิคการปรับแต่งภาพ  จ านวน  4 ช่ัวโมง 

 

1.  สาระส าคัญ 

 ภาพท่ีเราน าเขา้มาใชง้านในโปรแกรม InDesign นั้น ในบทน้ีเราจะมาท าการปรับแต่งทั้งภาพดว้ยเอฟ
เฟ็กตใ์นโปรแกรม การใชง้านภาพร่วมกบัขอ้ความรวมถึงการสร้างและการใชง้านเฟรม ซ่ึงจะท าใหภ้าพมี
ความน่าสนใจยิง่ข้ึน 

 

  
2. ผลการเรียนรู้ทีค่าดหวงั 

1. รู้และเขา้ใจในการตั้งค่าการแสดงผล 
2. อธิบายการปรับแต่งภาพได ้
3. สามารถจดัวางขอ้ความลอ้มรอบรูปภาพได ้
4. อธิบายการใชง้านเฟรมกบัภาพได ้
5. สามารถใส่ภาพรวมกบัขอ้ความได ้
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3.  กจิกรรมการเรียนรู้ 

กจิกรรมครู 

ข้ันน าเข้าสู่บทเรียน (สัปดาห์ละ 30 นาท)ี 
1.  ใหค้วามร่วมมือกบัครูในการตรวจสอบ 
2. คน้ควา้เร่ือง ส่ือส่ิงพิมพ ์
3. ร่วมสนทนาและแสดงความคิดเห็น 
4. ท าแบบทดสอบก่อนเรียน 
ขั้นด าเนินการสอน (สัปดาห์ละ 180 นาท)ี 
36. ฟัง ท าความเขา้ใจและซกัถาม 
37. แบ่งกลุ่ม 
38. ฟัง ท าความเขา้ใจและปฎิบติัตาม 
39. ผูเ้รียนซกัถามขอ้สงสัยและจดบนัทึก 
40.  รับการประเมิน 
ข้ันสรุป (สัปดาห์ละ 30 นาท)ี 
36. ครูและนกัเรียนร่วมกนัสรุปสาระส าคญั 
37. นกัเรียนสอบถามขอ้สงสัย 
38. ฟังและจดบนัทึก 
39. ท าแบบฝึกหดัทา้ยบท 
40. ท าแบบทดสอบหลงัเรียน 

 

กจิกรรมนักเรียน 

ข้ันน าเข้าสู่บทเรียน (สัปดาห์ละ 30 นาท)ี 
1.  ใหค้วามร่วมมือกบัครูในการตรวจสอบ 

2. คน้ควา้เร่ือง การออกแบบส่ือส่ิงพิมพ ์

3. ร่วมสนทนาและแสดงความคิดเห็น 
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4.  ท าแบบทดสอบก่อนเรียน 

ขั้นด าเนินการสอน (สัปดาห์ละ 180 นาท)ี 
1. ฟัง ท าความเขา้ใจและซกัถาม 
2. แบ่งกลุ่ม 
3. ฟัง ท าความเขา้ใจและปฎิบติัตาม 
4. ผูเ้รียนซกัถามขอ้สงสัยและจดบนัทึก 
5.  รับการประเมิน 
ข้ันสรุป (สัปดาห์ละ 30 นาท)ี 
1. ครูและนกัเรียนร่วมกนัสรุปสาระส าคญั 

2. นกัเรียนสอบถามขอ้สงสัย 

3. ฟังและจดบนัทึก 

4. ท าแบบฝึกหดัทา้ยบท 

5. ท าแบบทดสอบหลงัเรียน 

4.   กจิกรรมการเรียนรู้ 

 ก่อนเรียน 
3. คน้ควา้ค าเก่ียวกบัเทคนิคการปรับแต่งภาพ 
 ขณะเรียน 

1. ท าความเขา้ใจและปฎิบติัตามในแต่ละหวัขอ้การเรืยน 

2. ท าใบงานและแบบฝึกหดัหลงัเรียน 

3. ร่วมกนัเฉลยใบงานและแบบฝึกหดัหลงัเรียน 

4. จดบนัทึก เทคนิค แนวการท่ีเป็นประโยชน์ต่อผูเ้รียน จากขอ้แนะน าของครูผูส้อน 

5. ผูเ้รียนสรุปความรู้ท่ีไดจ้ากการเรียนตามความเป็นจริง จากภูมิความรู้ของผูเ้รียนแต่ละคน 

6. ผูเ้รียนซกัถามในหวัขอ้ท่ีสงสัยในเน้ือหาการเรียนรู้ 

5.  ส่ือการเรียนการสอน 

1. หนงัสือประกอบการเรียนวชิา การผลิตส่ือส่ิงพิมพ ์
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2. แฟ้มสะสมผลงาน   

3. ใบความรู้ประจ าหน่วย 

     4. เคร่ืองไมโครคอมพิวเตอร์ 

5. แผน่ใสและเคร่ืองฉายภาพขา้มศีรษะ 

6. ซีดีส่ือการสอนเร่ืองระบบฐานขอ้มูล 

6. วดัผลประเมินผล 

1. ผูเ้รียนปฏิบติัภาระงานท่ีมอบหมายเสร็จทนัเวลาท่ีก าหนด 

2. ตอบค าถามและสรุปผลงานไดอ้ยา่งถูกตอ้ง 

3. ท าแบบฝึกหดัหลงัเรียนเสร็จทนัเวลาท่ีก าหนดและถูกตอ้ง  

4. สนใจกระตือรือร้นในการเรียนรู้ ตอบค าถาม สรุปสาระการเรียนรู้ และกลา้แสดงความคิดเห็น 

7.   กจิกรรมเสนอแนะ 

ถา้ผูเ้รียนมีการเตรียมตวัในการเรียนท่ีดี เช่น อ่าน และท าการศึกษาหนงัสือเก่ียวกบัหน่วยการเรียนมาก
ก่อน ถึงชั่วโมงเรียน ผูเ้รียน จะสามารถเรียน และท ากิจกรรมต่าง ๆ ท่ีครูผูส้อนมอบหมาย ไดอ้ย่างมีความสุข 
และเกิดความชอบ และสนุกกบัการเรียนในชั้นเรียน 

เฉลยแบบฝึกหัดหน่วยที ่ 11 

ตอนท่ี 1 จงตอบค าถามต่อไปน้ี 

 

1. การแยกรูปภาพออกเป็นวตัถุอิสระ มีวธีิการอยา่งไร 

1. คลิกท่ี Direction Selection Tool แล้วคลิกท่ีวตัถุ 

2. เลือกค าส่ัง Edit->Cut 

3. เลือกค าส่ัง Edit->Paste  เพ่ือวางภาพนอกพืน้ท่ีเฟรม 

4. วตัถุเฟรมและรูปภาพถกูแยกออกจากกัน 
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2. การใส่รูปภาพลงในเฟรมมีวธีิการอยา่งไร  

ก่อนท่ีจะใส่รูปภาพลงในเฟรม ต้องท าการสร้างเฟรมจากเคร่ืองมือ Frame Tool จากกล่องเคร่ืองมือ ซ่ึง
สามารถสร้างได้ท้ังรูปส่ีเหลี่ยม  รูปวงกลม  และรูปหลายเหลี่ยม  ดังนี ้
1. 1 คลิกปุ่มเคร่ืองมือค้างไว้จะแสดงรูปแบบเฟรมท้ังหมด 
1.2 เลือกเคร่ืองมือการสร้างเฟรมท่ีต้องการ 
2. ลากเมาส์เพ่ือวาดเฟรม 
3. ปล่อยเมาส์ จะได้เฟรมท่ีวาดไว้ 

การใส่รูปภาพลงในเฟรม 

1. คลิกเลือกรูปภาพท่ีต้องการบรรจุลงในเฟรม 

2. เลือกค าส่ัง Edit->Cut 

3. คลิกเลือกเฟรมทีต้องการใส่รูปภาพ 

4. เลือกค าส่ัง Edit->Paste  into 

 

3. การลบรูปภาพท่ีอยูใ่นเฟรมมีวธีิการอยา่งไร 

1. คลิกท่ี Direction Selection Tool แล้วคลิกเลือกเฟรมท่ีบรรจุรูปภาพ 

2. เลือกค าส่ัง Edit->Clear เพ่ือลบรูปภาพออกจากเฟรม 

3. รูปภาพท่ีอยู่ในเฟรมจะถกูลบทิง้ไป 

 

4. ลกัษณะของการปรับแต่งเอฟเฟ็กตใ์หก้บัวตัถุต่างๆ มีอะไรบา้ง 

 Drop Shadow  สร้างเงาใหก้บั Object, Stroke, Fill, และ Text ดา้นนอกของกรอบเฟรม 

 Inner Shadow  สร้างเงาดา้นในวตัถุ Object, Stroke, Fill, และ Text ดา้นในกรอบเฟรม 

 Outer Glow  สร้างรัศมีของแสดงบริเวณกรอบนอกของวตัถุ 

 Inner Glow  สร้างรัศมีของแสดงบริเวณกรอบในของวตัถุ 

 Bevel and Emboss สร้างมุมเหล่ียมและลายนูนใหก้บัวตัถุ 
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 Satin   สร้างเงาอยา่งหยาบดา้นในวตัถุ 

 Basic Feather  ไล่เฉดสีใหค้่อยๆ อ่อนลง โดยบริเวณมุมของวตัถุจะเป็นมุมโคง้ 

 Directional Feather   ไล่เฉดสีใหค้่อยๆ อ่อนลง โดยบริเวณมุมของวตัถุ จะเป็นมุมเหล่ียม 
 Gradient Feather  ไล่เฉดสีใหค้่อยๆ อ่อนลงทั้งวตัถุ 

5. รูปแบบของกรอบภาพท่ีอยูใ่นพาเนล Text Wrap หมายถึงอะไรบา้ง 

 

 

 

 

ตอนท่ี 2 จงท าเคร่ืองหมาย  ลอ้มรอบตวัเลือกท่ีถูกตอ้งท่ีสุด 

1. จงเรียงล าดบัขั้นตอนท่ีถูกตอ้งของการเล่ือนภาพในเฟรมใหอ้ยูใ่นต าแหน่งท่ีเหมาะสม 

1. ปล่อยเมาส์ภาพในเฟรมจะแสดงอยูใ่นต าแหน่งท่ีตอ้งการ 

2. คลิกเลือก  Position Tool 

3. คลิกเมาส์คา้งไวท่ี้ภาพ ตวัช้ีเมาส์จะเปล่ียนเป็น  จากนั้นเล่ือนภาพให้อยูใ่นต าแหน่งท่ีตอ้งการ 

ก. 3 2 1     ข. 1 2 3 

ค. 1 3 2    ง. 2 3 1 

No text wrap   ไม่มกีรอบภาพ ข้อความไหลปกติ 

 

 
Wrap around bounding box  ข้อความจะเว้นช่องเป็นกรอบภาพส่ีเหลี่ยม 

Wrap around object shape   ข้อความจะเว้นช่องเป็นรูปทรงรอบกรอบภาพ 

Jump object      ข้อความไหลแบบกระโดดข้ามรูปภาพและไหลต่อไป 

Jump to next column  ข้อความไหลเฉพาะด้านบนก่อนถึงภาพ และข้อความท่ี 

    เหลือจะไหลต่อเป็นวตัถใุหม่ ในต าแหน่งท่ีก าหนดได้เอง 
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2. รูปแบบการแสดงภาพกราฟิก ลายเส้น ท่ีมีความละเอียดสูง หมายถึงขอ้ใด 

ก. Currently    ข. High Quality 

ค. Fast     ง. Typical 

3. Ellipse Frame Tool เป็นเคร่ืองมือท่ีใชส้ร้างเฟรมในรูปแบบใด 

ก. เฟรมรูปส่ีเหล่ียม   ข. เฟรมรูปวงกลม 

ค. เฟรมรูปสามเหล่ียม   ง. เฟรมรูปหลายเหล่ียม 

4. Rectangle Frame Tool เป็นเคร่ืองมือท่ีใชส้ร้างเฟรมในรูปแบบใด 

ก. เฟรมรูปส่ีเหลี่ยม   ข. เฟรมรูปวงกลม 

ค. เฟรมรูปสามเหล่ียม   ง. เฟรมรูปหลายเหล่ียม 

5. ขอ้ใดต่อไปน้ีไม่เก่ียวขอ้งกบัขั้นตอนการใส่รูปภาพลงในเฟรม 

ก. เลือกค าส่ัง Edit->Paste  

ข. คลิกเลือกค าสั่ง Edit->Cut  

ค. คลิกเลือกเฟรมท่ีตอ้งการใส่รูปภาพ  

ง. คลิกเลือกรูปภาพท่ีตอ้งการบรรจุลงในเฟรม 

จงใชค้  าตอบต่อไปน้ีตอบค าถามขอ้ 6 - 8 

ก. Both Right & Left Sides  

ข. Right Side 

ค. Side Away from Spine 

ง. Largest Area 

6. ก าหนดการไหลของขอ้ความทางดา้นขวา หมายถึงขอ้ใด ตอบ ข้อ ข. 

7. ก าหนดการไหลของขอ้ความดา้นท่ีมีหยกันอ้ย หมายถึงขอ้ใด ตอบ ข้อ ค. 
8. ก าหนดการไหลของขอ้ความดา้นท่ีมีพื้นท่ีมากกกวา่ หมายถึงขอ้ใด ตอบ ข้อ ง. 
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9. Directional Feather หมายถึงขอ้ใด 

ก. สร้างรัศมีของแสดงบริเวณกรอบในของวตัถุ 

ข. สร้างเงาอยา่งหยาบดา้นในวตัถุ 

ค. ไล่เฉดสีใหค้่อยๆ อ่อนลงทั้งวตัถุ 

ง. ไล่เฉดสีให้ค่อยๆ อ่อนลง โดยบริเวณมุมของวตัถุ จะเป็นมุมเหลี่ยม 

10. Outer Glow หมายถึงขอ้ใด 

ก. สร้างรัศมีของแสดงบริเวณกรอบนอกของวตัถุ  

ข. สร้างมุมเหล่ียมและลายนูนใหก้บัวตัถุ  

ค. ไล่เฉดสีใหค้่อยๆ อ่อนลง โดยบริเวณมุมของวตัถุจะเป็นมุมโคง้  

ง. สร้างเงาอยา่งหยาบดา้นในวตัถุ 


